XP-950 User's Guide
## Contents

### XP-950 User’s Guide

13

### Product Basics

14

- Setting Up the Control Panel ................................................................. 14
- Control Panel Buttons and Lights .......................................................... 14
- Using the LCD Screen ........................................................................... 15
- Adjusting Control Panel Position .......................................................... 16
- Changing LCD Screen Language ............................................................ 16
- Turning Off Control Panel Sounds ......................................................... 16
- Turning Off Auto Selection Mode ........................................................... 17
- Turning On Quiet Mode ......................................................................... 17

17

- Product Parts Locations ........................................................................ 17
  - Product Parts - Top ............................................................................ 18
  - Product Parts - Front ......................................................................... 19
  - Product Parts - Inside ........................................................................ 20
  - Product Parts - Back ......................................................................... 21

21

- The Power Off and Sleep Timers ............................................................ 21
  - Changing the Power Off Timer Setting From the Control Panel ........ 22
  - Changing the Sleep Timer Setting From the Control Panel .............. 23
  - Changing the Power and Sleep Timer Settings - Windows ............... 25
  - Changing the Power and Sleep Timer Settings - Mac OS X ................ 26

28

- Epson Connect Solutions for Smartphones, Tablets, and More .............. 28
  - Using Epson Email Print ................................................................. 28
  - Using the Epson iPrint Mobile App .................................................... 28
  - Using Epson Remote Print ............................................................... 29
  - Using Epson Scan to Cloud .............................................................. 29
  - Using AirPrint .................................................................................. 30
  - Using Google Cloud Print ............................................................... 30

32

- Wi-Fi or Wired Networking .................................................................. 32
  - Wi-Fi Infrastructure Mode Setup ....................................................... 32
  - Selecting Wireless Network Settings From the Control Panel .......... 33
Wi-Fi Direct Mode Setup .................................................................................................................... 35
   Enabling Wi-Fi Direct Mode .................................................................................................................. 36
Wi-Fi Protected Setup (WPS) ................................................................................................................ 39
   Using WPS to Connect to a Network ...................................................................................................... 39
Printing a Network Status Sheet ............................................................................................................ 40
Changing or Updating Network Connections ........................................................................................ 42
   Accessing the Web Config Utility ........................................................................................................ 42
   Changing a USB Connection to a Wi-Fi Connection ......................................................................... 42
   Changing a Wi-Fi Connection to a Wired Network Connection ........................................................ 43
   Connecting to a New Wi-Fi Router ...................................................................................................... 43
   Disabling Wi-Fi Features .................................................................................................................... 44

Loading Paper ........................................................................................................................................... 45
   Loading Paper in Cassette 1 (Upper Cassette) .................................................................................. 45
   Loading Paper in Cassette 2 (Lower Cassette) .................................................................................. 48
   Loading Paper in the Rear Paper Feed Slot ....................................................................................... 52
   Loading Envelopes ............................................................................................................................ 57
   Paper Loading Capacity ..................................................................................................................... 60
   Available Epson Papers ....................................................................................................................... 61
   Borderless Paper Type Compatibility ................................................................................................. 64
   Paper or Media Type Settings ............................................................................................................. 65

Placing Originals on the Product ............................................................................................................. 66
   Placing Originals on the Scanner Glass ............................................................................................. 66

Copying ...................................................................................................................................................... 68
   Copying Documents or Photos ........................................................................................................... 68
   Paper Type Settings - Copying ............................................................................................................. 69
   Paper Size Settings - Copying ............................................................................................................. 70
   Copying Options ............................................................................................................................... 70
   Copying and Restoring Photos ............................................................................................................ 73

Printing From a Computer ........................................................................................................................ 75
   Printing with Windows ....................................................................................................................... 75
   Selecting Basic Print Settings - Windows ........................................................................................ 75
   Paper Source Options - Windows ..................................................................................................... 78
Starting a Scan Using the Product Control Panel ................................................................. 110
Scan to Memory Card Options ............................................................................................ 112
Changing Default Scan Button Settings ............................................................................. 113
Starting a Scan Using the Epson Scan Icon ........................................................................ 113
Starting a Scan from a Scanning Program ......................................................................... 116
Selecting Epson Scan Settings ........................................................................................... 117
Scan Modes ......................................................................................................................... 118
Selecting the Scan Mode ....................................................................................................... 118
Scanning in Full Auto Mode ................................................................................................. 119
   Available Image Adjustments - Full Auto Mode ................................................................. 122
Scanning in Home Mode ....................................................................................................... 122
   Selecting a Scan Area - Home Mode ................................................................................ 125
   Available Image Adjustments - Home Mode .................................................................... 128
   Selecting a Scan Size - Home Mode ................................................................................ 129
Scanning in Office Mode ...................................................................................................... 131
   Selecting a Scan Area - Office Mode .............................................................................. 133
   Available Image Adjustments - Office Mode ................................................................. 135
Scanning in Professional Mode ............................................................................................ 136
   Available Image Types - Professional Mode ................................................................. 139
   Selecting a Scan Area - Professional Mode ................................................................. 139
   Available Image Adjustments - Professional Mode ...................................................... 142
   Selecting a Scan Size - Professional Mode .................................................................... 144
Image Preview Guidelines .................................................................................................. 147
Scan Resolution Guidelines ................................................................................................. 147
Selecting Scan File Settings ............................................................................................... 148
   Available Scanned File Types and Optional Settings .................................................... 149
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture .......................................... 150
   Available Scan Settings - Mac OS X Image Capture ...................................................... 152
Scanning Special Projects ................................................................................................. 152
Scanning to a PDF File ........................................................................................................ 152
   Restoring Photo Colors as You Scan ............................................................................ 155
Using Memory Cards With Your Product ............................................................................ 157
Inserting a Memory Card .................................................................................................... 157
Printing on CDs/DVDs

CD/DVD Printing Features ................................................................. 191
Loading a CD/DVD ........................................................................... 191
Removing a Printed CD/DVD .......................................................... 194
Placing a CD/DVD on the Scanner Glass ........................................ 195
Copying onto a CD/DVD ................................................................. 195
Printing Photos from a Memory Card Onto a CD/DVD ...................... 197
Printing a Jewel Case Insert from a Memory Card ......................... 198
Printing on CDs/DVDs from a Computer ........................................ 200
  Printing on a CD/DVD with Windows ........................................... 200
  Designing a CD/DVD - Windows .................................................. 200
  Printing Your CD/DVD Design - Windows .................................... 201
  Adjusting CD/DVD Print Position - Windows ..................... 202
  Adjusting CD/DVD Print Quality - Windows .............................. 204
Printing on a CD/DVD with Mac OS X ........................................... 205
  Designing a CD/DVD - Mac OS X .............................................. 206
  Printing Your CD/DVD Design - Mac OS X .......................... 207
  Adjusting CD/DVD Print Position - Mac OS X ....................... 207
  Adjusting CD/DVD Print Quality - Mac OS X ....................... 209

Replacing Ink Cartridges ................................................................. 211
  Check Cartridge Status ............................................................. 211
  Checking Cartridge Status on the LCD Screen ......................... 211
  Checking Cartridge Status with Windows ................................. 212
  Checking Cartridge Status with Mac OS X ............................... 215
  Purchase Epson Ink Cartridges .................................................. 216
  Ink Cartridge Part Numbers ...................................................... 216
  Removing and Installing Ink Cartridges ........................................ 217
  Printing With Black Ink and Expended Color Cartridges ............... 221
    Printing With Expended Color Cartridges - Windows ............ 221
    Printing With Expended Color Cartridges - Mac OS X ........ 222
  Conserving Low Black Ink with Windows .............................. 223

Adjusting Print Quality ................................................................. 225
  Print Head Maintenance ............................................................ 225
Print Head Nozzle Check
Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility
Print Head Cleaning
Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility
Print Head Alignment
Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility
Cleaning the Paper Path

Cleaning and Transporting Your Product
Cleaning Your Product
Transporting Your Product

Solving Problems
Checking for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Noise After Ink Installation
Software Installation Problems
Control Panel Setup Problems
Solving Network Problems
Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network
Product Does Not Appear in Mac OS X Printer Window
Cannot Print Over a Network
Cannot Scan Over a Network
Solving Copying Problems
Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While
Solving Paper Problems
Paper Feeding Problems
Image is Too Dark ....................................................................................................................... 273
Back of Original Image Appears in Scanned Image ................................................................. 274
Ripple Patterns Appear in an Image ........................................................................................ 274
Scanned Image Colors Do Not Match Original Colors ........................................................... 274
Scan Area is Not Adjustable in Thumbnail Preview .................................................................. 275
Scanned Image Edges are Cropped ......................................................................................... 275
Solving Memory Card Problems ............................................................................................. 275
  Memory Card Does Not Fit Into a Slot .................................................................................. 275
  Cannot View or Print Photos from a Memory Card ............................................................... 276
  Cannot Transfer Photos To or From a Memory Card ............................................................ 276
When to Uninstall Your Product Software ............................................................................. 277
  Uninstalling Product Software - Windows ............................................................................ 277
  Uninstalling Product Software - Mac OS X .......................................................................... 278
Where to Get Help ..................................................................................................................... 279
Technical Specifications ........................................................................................................... 280
  Windows System Requirements ............................................................................................ 280
  Mac System Requirements ................................................................................................... 281
  Printing Specifications ......................................................................................................... 281
  Scanning Specifications ....................................................................................................... 282
  Paper Specifications ............................................................................................................. 282
  Printable Area Specifications ............................................................................................... 283
  Ink Cartridge Specifications ................................................................................................. 285
  Memory Card Specifications ............................................................................................... 286
  Dimension Specifications ...................................................................................................... 287
  Electrical Specifications ....................................................................................................... 288
  Environmental Specifications .............................................................................................. 288
  Interface Specifications ........................................................................................................ 289
  External USB Device Specifications ..................................................................................... 289
  Network Interface Specifications ......................................................................................... 289
  Safety and Approvals Specifications .................................................................................... 290
Notices ....................................................................................................................................... 292
  Important Safety Instructions ............................................................................................... 292
  General Product Safety Instructions ..................................................................................... 292
11
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink Cartridge Safety Instructions</td>
<td>294</td>
</tr>
<tr>
<td>LCD Screen Safety Instructions</td>
<td>295</td>
</tr>
<tr>
<td>Wireless Connection Safety Instructions</td>
<td>295</td>
</tr>
<tr>
<td>FCC Compliance Statement</td>
<td>295</td>
</tr>
<tr>
<td>Software Notice</td>
<td>296</td>
</tr>
<tr>
<td>Trademarks</td>
<td>298</td>
</tr>
<tr>
<td>Copyright Notice</td>
<td>299</td>
</tr>
<tr>
<td>libTIFF Software Acknowledgment</td>
<td>299</td>
</tr>
<tr>
<td>A Note Concerning Responsible Use of Copyrighted Materials</td>
<td>300</td>
</tr>
<tr>
<td>Default Delay Times for Power Management for Epson Products</td>
<td>300</td>
</tr>
<tr>
<td>Copyright Attribution</td>
<td>300</td>
</tr>
</tbody>
</table>
Welcome to the XP-950 User's Guide.

For a printable PDF copy of this guide, click here.
Product Basics

See these sections to learn about the basic features of your product.
Setting Up the Control Panel
Product Parts Locations
The Power Off and Sleep Timers
Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint
Using Google Cloud Print

Setting Up the Control Panel

See these sections to set up the control panel for use.
Control Panel Buttons and Lights
Using the LCD Screen
Adjusting Control Panel Position
Changing LCD Screen Language
Turning Off Control Panel Sounds
Turning Off Auto Selection Mode
Turning On Quiet Mode
Parent topic: Product Basics

Control Panel Buttons and Lights
1. The power button and the power light
2. The home button
3. The LCD screen
4. The up and down arrows (you can also scroll by swiping up and down on the LCD screen with your finger)
5. The CD button
6. The back button
7. The start button

Parent topic: Setting Up the Control Panel

Using the LCD Screen

1. Displays the screen name
2. Displays product status information; tap the icons to display additional menus or information
3. Swipe this area of the LCD screen to scroll up and down

To view a list of the icons and a description of their use, select Help > Icon List.

Parent topic: Setting Up the Control Panel
Adjusting Control Panel Position
You can adjust the position of the control panel to make it easier to access. Raise or lower it to the desired angle as shown.

Note: The control panel rises and the output tray slides out automatically when printing starts.

Parent topic: Setting Up the Control Panel

Changing LCD Screen Language
You can change the language used on the LCD screen.
1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select Basic Setup.
4. Select Language.
5. Select a language.
6. Press the home button to exit.

Parent topic: Setting Up the Control Panel

Turning Off Control Panel Sounds
You can turn off the sound heard when you press buttons on the control panel.
1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
4. Select Sound.
5. Select **Button Press**.
6. Select the **Off** setting.
7. Press the 🏠 home button to exit.

**Parent topic:** Setting Up the Control Panel

**Turning Off Auto Selection Mode**

Auto Selection Mode changes the menu options on the LCD screen automatically depending on the action you perform. For instance, loading a memory card displays memory card-related menu options on the screen. You can turn off this feature from the product's control panel.

1. Press the 🏠 home button, if necessary.
2. Select **Setup**.
3. Select **Guide Functions**.
4. Select **Auto Selection Mode**.
5. Turn off the desired options displayed on the screen.

**Parent topic:** Setting Up the Control Panel

**Turning On Quiet Mode**

You can reduce the noise the product makes by turning on the Quiet Mode option.

**Note:** Turning on this setting may reduce print speed.

1. Press the 🏠 home button, if necessary.
2. Select **Setup**.
3. Select **Printer Setup**.
4. Select **Quiet Mode**.
5. Select the **On** setting.
6. Press the 🏠 home button to exit.

**Parent topic:** Setting Up the Control Panel

**Product Parts Locations**

See these sections to identify the parts on your product.
Product Parts - Top

1. Rear paper feed slot cover
2. Paper support
3. Rear paper feed slot
4. Edge guide
5. CD/DVD tray (shown removed and in storage position)
6. Document cover

Parent topic: Product Parts Locations
1 Control panel
2 Output tray
3 Cassette 1 (upper cassette)
4 Cassette 2 (lower cassette)
5 Front cover
6 Cassette edge guides
1 Document cover
2 Scanner glass
3 Memory card access light
4 Memory card slots
5 USB Type A port for external devices

**Parent topic:** Product Parts Locations

**Product Parts - Inside**
1. Scanner unit
2. Print head/ink cartridge holder

**Product Parts - Back**

1. AC inlet
2. Rear cover
3. LAN port
4. USB port

**The Power Off and Sleep Timers**

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can adjust the time period before power management, but increasing the time reduces the product’s energy efficiency.

- Changing the Power Off Timer Setting From the Control Panel
- Changing the Sleep Timer Setting From the Control Panel
- Changing the Power and Sleep Timer Settings - Windows
- Changing the Power and Sleep Timer Settings - Mac OS X

**Parent topic:** Product Basics
Changing the Power Off Timer Setting From the Control Panel

You can use the product's control panel to change the time period before the printer turns off automatically.

1. Press the home button, if necessary.
2. Select Setup.
3. Select Printer Setup.
   You see this screen:

![Printer Setup Menu]

4. Press the up or down arrow buttons to select Power Off Timer.
   You see this screen:
5. Press the up or down arrow buttons to select the length of time after which you want the product to automatically turn off when it is not in use.

6. Press the ⤵️ home button to exit.

**Parent topic:** The Power Off and Sleep Timers

### Changing the Sleep Timer Setting From the Control Panel

You can use the product's control panel to change the time period before the product enters sleep mode.

1. Press the ⤵️ home button, if necessary.
2. Select **Setup**.
3. Select **Printer Setup**.

   You see this screen:
4. Press the up or down arrow buttons to select **Sleep Timer**.
   You see this screen:

5. Press the up or down arrow buttons to select the time period you want before the product goes to
   sleep.

6. Press the ⌂ home button to exit.

**Parent topic:** [The Power Off and Sleep Timers](#)
Changing the Power and Sleep Timer Settings - Windows

You can use the printer software to change the time period before the printer enters sleep mode or turns off automatically.

1. Do one of the following:
   - **Windows 8**: Navigate to the **Start** screen, right-click the screen, and select **Devices and Printers**. Right-click your product name and select **Printing Preferences**.
   - **Windows 7**: Click and select **Devices and Printers**. Right-click your product name and select **Printing Preferences**.
   - **Windows Vista**: Click and select **Control Panel**. Click **Printer** under **Hardware and Sound**, right-click your product name, and select **Printing Preferences**.
   - **Windows XP**: Click **Start** and select **Printers and Faxes**. (Or open the **Control Panel**, select **Printers and Other Hardware** if necessary, and select **Printers and Faxes**.) Right-click your product name and select **Printing Preferences**.

2. Click the **Maintenance** tab.

3. Click the **Printer and Option Information** button.

You see the Printer and Option Information screen:
4. Select the length of time after which you want the product to automatically turn off when it is not in use as the **Power Off Timer** setting.

5. Click **Send**.

6. Select the time period you want before the product goes to sleep as the **Sleep Timer** setting.

7. Click **Send**.

8. Click **OK** to close the open program windows.

**Parent topic:** [The Power Off and Sleep Timers](#)

### Changing the Power and Sleep Timer Settings - Mac OS X

You can use the printer software to change the time period before the printer enters sleep mode.
1. Do one of the following:
   • **Mac OS X 10.6/10.7/10.8**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax** or **Print & Scan**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
   • **Mac OS X 10.5**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, select your product, and select **Open Print Queue** or **Print Queue**. Select **Utility**.

2. Select **Printer Settings**.
   You see this screen:

   ![Printer Settings screen](image)

   3. Select the length of time after which you want the product to automatically turn off when it is not in use as the **Power Off Timer** setting.
   4. Select the time period you want before the product goes to sleep as the **Sleep Timer** setting.
   5. Click **Apply**.
   6. Close the Printer Settings window.
Epson Connect Solutions for Smartphones, Tablets, and More

You can print documents, photos, emails, and web pages from your home, office, or even across the globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print and scan from anywhere: Epson Email Print, Epson iPrint Mobile App, Epson Remote Print, and Epson Scan to Cloud.

Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone, tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a PDF, Microsoft Office document, or photo and send an email to your product.

1. Set up your product for network printing as described on the Start Here sheet.
2. If you did not already set up Email Print when you installed your product software, visit epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup instructions.
3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by logging into your Epson Connect account.

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless network. You can even scan and save a file on your device, send it as an email, or upload it to an online service such as Box, Dropbox, Evernote, or Google Drive.

1. Set up your product on a network as described in this manual. See the links below.
2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile device.
3. Download Epson iPrint from the Apple App Store or Google Play.
4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

### Using Epson Remote Print

With Epson Remote Print software on your Windows computer or laptop, you can print to an Epson Email-enabled product anywhere in the world.

1. Visit epson.com/connect to learn more about Remote Print and how to download the software.
2. Download and install the Remote Print software.
3. Obtain the email address and optional access key of the Epson product you want to use for printing, and enter this address during Remote Print setup.
4. Select the print command in your application and choose the Remote Print driver for your Epson product.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More

### Using Epson Scan to Cloud

The Epson Scan to Cloud service sends your scanned files to a destination that you have registered with Epson Connect.

1. Set up your product for network printing as described on the Start Here sheet.
2. Visit epson.com/connect for instructions on registering an account and your product with Epson Connect.
3. After registering, sign in to the Epson Connect web page with the email address and password you selected.
4. Select Destination List for Scan to Cloud.
5. Click Add, then follow the instructions on the screen to create your destination list.
6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control panel.

**Parent topic:** Epson Connect Solutions for Smartphones, Tablets, and More
Related tasks
Starting a Scan Using the Product Control Panel

Using AirPrint
AirPrint allows you to wirelessly print to your AirPrint-enabled product from iPhone, iPad, and iPod touch running the latest version of iOS.
1. Set up your product for wireless printing as described on the Start Here sheet.
2. Connect your Apple device to the same wireless network that your product is using.
3. Print from your iPad, iPhone, or iPod touch to your product.

Parent topic: Product Basics

Using Google Cloud Print
With a Google Account, you can print from your Apple or Android device to your Epson product. You can also print from Chromebooks and the Google Chrome browser without drivers or cables.

If you are setting up your product for the first time, set up your Epson product for network printing as described on the Start Here sheet.

Note: Make sure your Epson printer and computer are connected to the same network before starting the Google Cloud Print setup.

If your product is already on your network, follow these steps:
1. Connect your device to the same network that your Epson product is using.
2. Print a network status sheet.
3. Locate your product's IP address on the network status sheet.
4. Enter the IP address into the address bar of a web browser.
5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If the option still doesn't appear, select the Firmware Update option and follow the on-screen instructions to update your product.

6. Click Register.
7. Select the check box to agree to the Usage Advisory and click Next.
8. Click **OK** to launch the sign-in page.
   A separate browser window opens.

9. Enter your Google Account username and password and click **Sign in**, or, if you don't have an account, click **Sign up for a new Google Account** and follow the on-screen instructions.

10. Click **Finish printer registration** to complete setup and print a test page.

    Your product is now linked to your Google Account and can be accessed from any Chromebook, computer, Apple or Android device with internet access. Visit [Epson Support](https://www.epson.com) for more information on using Google Cloud Print, or the [Google Cloud Print](https://cloud.printing.google.com) website for a list of supported apps.

**Parent topic:** Product Basics

**Related tasks**

- Printing a Network Status Sheet
Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup
Wi-Fi Direct Mode Setup
Wi-Fi Protected Setup (WPS)
Printing a Network Status Sheet
Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point. The wireless router or access point can be connected to your computer over a wireless or wired network.

1   Epson product
2   Wireless router or access point
Selecting Wireless Network Settings From the Control Panel

Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel

You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install the necessary software from the product CD. The installer program guides you through network setup.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.
   
   You see this screen:

3. Select Wi-Fi Setup Wizard.

   Note: If you need to disable the wireless network to set up your product on an Ethernet network, scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired network connection in this guide.
4. Select the name of your wireless network or enter the name manually.

   **Note:** To enter the wireless network name manually, scroll down and then select **Other Networks**. Use the displayed keypad to enter your network name, as described in the next step.

5. Enter your wireless password (or network name and then password) using the displayed keypad.

   ![Enter Password Keypad](image)

   **Note:** The network name and password are case sensitive. Be sure to correctly enter uppercase and lowercase letters, and numeric or special characters.

   • Press the touch screen buttons repeatedly to scroll through characters.
   • Press ≥ or ≤ to move the cursor.
   • Press 1 Symb. to enter symbols.
   • Press ≥ to delete the previous character.

6. Press **Done** when you’re finished entering your password.
7. Confirm the displayed network settings and select **Proceed** to save them.

   **Note:** If you need to change a setting, press the 3 back button.

8. If you want to print a network setup report, press the ⚡ start button. (Otherwise, select **Done**.)
   If the network connection is successful, a Wi-Fi antenna icon with blue connection bars is displayed in the upper-left corner of the LCD screen.
Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without requiring a wireless router or access point.

1. Epson product
2. Computer with a wireless interface
3 Other wireless device

Your product automatically selects one of these modes to communicate with your computer or device:

**Access point mode**
If your product is not already connected to a wireless network, it enters access point mode and the product itself acts as the network access point for up to 4 devices. When operating in this mode, your product displays an AP connection symbol on the LCD screen.

**Peer-to-peer mode**
If your product is already connected to a wireless network, it enters peer-to-peer mode and disconnects from any other networks. This also disables any other product features requiring access to the Internet. When operating in this mode, your product displays a Direct or D connection symbol on the LCD screen.

**Note:** To disconnect a peer-to-peer mode connection, release the connection to your product from your computer or other device. Your product will reconnect to the previously used network.

**Enabling Wi-Fi Direct Mode**

**Parent topic:** Wi-Fi or Wired Networking

## Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or other devices without a wireless router or access point.

1. Press the home button, if necessary.
2. Select Wi-Fi Setup.
   You see this screen:
3. Scroll down and select **Wi-Fi Direct Routerless Setup**.
4. Select **Connection Setup**.
5. Select **Change Password**, then select **OK**.
   
   **Note:** If you have already connected devices or computers to your product via Wi-Fi Direct, they will be disconnected when you change the password.

6. Enter your Wi-Fi Direct password.
   
   **Note:** Your password must be at least 8 and no more than 22 characters long.
• Press the touch screen buttons repeatedly to scroll through characters.
• Press ← or → to move the cursor.
• Press 1 Symb. to enter symbols.
• Press ▼ to delete the previous character.

7. Press Done when you finish entering your password.
   You see this screen:

   ![Wi-Fi Direct Routerless Setup screen](image)

   Connecting via Wi-Fi Direct mode... Select the Wi-Fi network (SSID) below to establish a connection to this printer.

   ![Cancel button](image)

8. Scroll down to view the SSID (Wi-Fi network name) and password.
9. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the LCD screen, then enter the password shown.

10. Press the home button to exit.

You see either an AP or Direct connection symbol on the LCD screen and should be able to print directly to your product from your computer or device.

**Note:** If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode is not enabled. Repeat these steps to try again.

**Parent topic:** Wi-Fi Direct Mode Setup

## Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your product to the network using Wi-Fi Protected Setup (WPS).

**Note:** To check if your router is WPS-enabled, look for a button labeled **WPS** on your router or access point. If there is no hardware button, there may be a virtual WPS button in the software for the device. Check your network product documentation for details.

**Using WPS to Connect to a Network**

**Parent topic:** Wi-Fi or Wired Networking

### Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to connect your product to the network.

1. Press the home button, if necessary.
2. Select **Wi-Fi Setup**.

You see this screen:
3. Select **Push Button Setup (WPS)**.
4. Follow the instructions on the LCD screen to complete WPS setup.

   If the network connection is successful, a Wi-Fi antenna icon with blue connection bars is displayed in the upper-left corner of the LCD screen.

**Parent topic:** [Wi-Fi Protected Setup (WPS)]

**Printing a Network Status Sheet**

You can print a network status sheet to help you determine the causes of any problems you may have using your product on a network.
1. Press the home button, if necessary.

2. Select **Wi-Fi Setup**.
   
   You see this screen:

   ![Wi-Fi Setup Screen](image)

3. Select **Wi-Fi/Network Status**.

   You see a screen like this:

   ![Wi-Fi/Network Status Screen](image)

   **Note:** If you are connected to a network wirelessly, the signal strength is also displayed.

4. Select **Status Sheet**, then press the start button to print the network status sheet.
(Select Cancel if you want to cancel the operation.)
Examine the settings shown on the network status sheet to diagnose any problems you have.

Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility
Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router
Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility
You can select your product's network settings and confirm its operating status using a web browser. You do this by accessing your product's built-in Web Config utility from a computer or other device that is connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.
3. On a computer or other device connected to the same network as your product, open a web browser.
4. Enter your product's IP address into the address bar.
   You see the available Web Config utility options.

Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection
If you have already connected your product to your computer using a USB connection, you can change to a Wi-Fi connection or add a Wi-Fi connection to print wirelessly.

1. Do one of the following:
   - If you want to use only a Wi-Fi connection, disconnect the USB cable from your product. With Windows, also uninstall your product software.

42
• If you want to add a Wi-Fi connection in addition to a USB connection, leave the USB cable connected to your product.

2. Download your product software from the Epson website, or install it from the CD that came with your product using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired network connection if necessary.

1. Disable your product's Wi-Fi features.
2. Connect one end of an Ethernet network cable to the product’s LAN port.
3. Connect the other end to any available LAN port on your router or access point.
4. Download and install your product software from the Epson website, or install it from the CD that came with your product.
5. Follow the on-screen instructions to install the software.
6. When you see the Select Your Connection screen, select Wired network connection.
7. If you see a Select Setup Option screen, select Setup printer for the first time.
8. Continue following the rest of the on-screen instructions.

Parent topic: Changing or Updating Network Connections

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you can update your product's Wi-Fi connection to the new router.

1. Do one of the following:
   - Windows: Uninstall your product software.
   - Mac OS X: Go to the next step.
2. Download your product software from the Epson website, or install it from the CD that came with your product using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections
Disabling Wi-Fi Features

You may need to disable your product’s Wi-Fi features if you change your network connection type or need to solve a problem with your network connection.

**Note:** Before disabling Wi-Fi features, make a note of your product’s SSID (network name) and password, and any network settings selected for the Epson Connect services you may use.

1. Press the 🏛️ home button, if necessary.
2. Select **Wi-Fi Setup**.
   
   You see this screen:

   ![Wi-Fi Setup Screen](image)

3. Scroll down and select **Disable Wi-Fi**.
4. Select **Yes** to disable Wi-Fi.

**Parent topic:** Changing or Updating Network Connections
Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes
Paper Loading Capacity
Available Epson Papers
Borderless Paper Type Compatibility
Paper or Media Type Settings

Loading Paper in Cassette 1 (Upper Cassette)

You can load photo paper and other media in these sizes in the upper paper cassette:

- 3.5 × 5 inches (89 × 127 mm)
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.
2. Open the front cover.

3. Pull out the upper paper cassette. The upper cassette has a label on the right side.

   Note: If the cassette is too far inside the product to reach, turn the product off and then back on again to reset the cassette's position.

4. Slide the edge guides outward.
5. Set the front edge guide to the position for the paper size you are using.

Note: Various paper sizes are marked on the tray.

6. Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the front edge guide.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
8. Keep the cassette flat as you insert it until the left and right arrow marks on the tray and product line up.

![Image of paper cassette]

**Note:** The output tray opens automatically when you print. Leave enough space in front of the product for the paper to be fully ejected. Do not remove or insert the paper cassette while the product is operating.

Always follow these paper loading guidelines:

- Load only the recommended number of sheets.
- Load paper short edge first and printable side facedown.
- Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the cassette.
- Check the paper package for any additional loading instructions.

**Parent topic:** Loading Paper

**Related references**

- Paper Loading Capacity

**Related tasks**

- Loading Paper in Cassette 2 (Lower Cassette)
- Loading Paper in the Rear Paper Feed Slot
- Loading Envelopes

### Loading Paper in Cassette 2 (Lower Cassette)

You can load paper up to this size in the lower paper cassette: Legal (8.5 × 14 inches [216 × 357 mm]).
**Note:** Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

   ![Diagram of printer with output tray open](image)

   **Note:** As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.

   ![Diagram of printer with front cover open](image)

3. Pull on the front cover to pull out the lower paper cassette.

   ![Diagram of lower paper cassette being pulled out](image)
4. Slide the edge guides outward.

**Note:** If you are using legal-size paper, remove the CD/DVD tray from the product. Press the button on the cassette and then extend it as shown.

5. Set the front edge guide to the paper size you are using.

**Note:** Various paper sizes are marked on the tray.
6. Insert paper with the glossy or printable side facedown.

![Image showing paper insertion]

**Note:** Make sure the paper is loaded against the edge guide and not sticking out from the end of the cassette.

7. Slide the side edge guides against the paper, but not too tightly.

![Image showing edge guide positioning]

**Note:** Make sure the paper is under the tabs on the edge guides.
8. Keep the cassette flat as you insert it.

**Note:** The output tray opens automatically when you print. Leave enough space in front of the product for the paper to be fully ejected. Do not remove or insert the paper cassette while the product is operating.

Always follow these paper loading guidelines:

- Load only the recommended number of sheets.
- Load paper short edge first and printable side facedown.
- Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the cassette.
- Check the paper package for any additional loading instructions.

**Parent topic:** Loading Paper

**Related references**

- Paper Loading Capacity

**Related tasks**

- Loading Paper in Cassette 1 (Upper Cassette)
- Loading Paper in the Rear Paper Feed Slot
- Loading Envelopes

### Loading Paper in the Rear Paper Feed Slot

You can load card stock, envelopes, and other thick media in the rear paper feed slot.

**Note:** Paper that is too stiff may not load correctly even if it is within the paper specifications.
1. Send your print job from a computer or using the product's touch screen.
   • If printing from a computer, select **Rear Paper Feed Slot** for the **Source** (Windows) or **Paper Source** (Mac OS X) setting.
   • If printing from the product's touch screen, select **Rear Paper Feed Slot** for the **Paper Source** setting.

2. Flip open the rear paper feed slot cover.

3. Extend the paper support and tilt it back.
4. Slide the edge guides outward.

5. Do one of the following:
   • Load a single sheet of paper or thick media, printable side up and short edge first, in the center of the rear paper feed slot until you hear a beep. Slide the edge guides against the paper, but not too tightly.

   • Load an envelope, short edge first with the flap facing down, in the center of the rear paper feed slot until you hear a beep. Slide the edge guides against the envelope, but not too tightly.
6. When you are ready to print, press the ◇ start button.

   **Note:** To cancel printing, select **Cancel**. If the **Button Press** setting is turned off, you do not hear a beep when inserting paper.

Always follow these loading guidelines:

- Load one sheet or envelope at a time.
- Be careful not to insert paper too far or not far enough. Feed about 2 inches (5 cm) of paper into the printer as shown.
1 2 inches (5 cm)

- Do not insert paper at an angle, or it may cause a paper jam or wrinkle your printout.

- You can load hole-punched paper with holes on either side, but you may need to adjust the margins in your print file to avoid printing over the holes.

- Check the paper package for any additional loading instructions.

Parent topic: Loading Paper

Related references

Paper Loading Capacity
Loading Envelopes

You can load envelopes in Cassette 2 (lower cassette) as described here. You can print on plain paper envelopes in this size: No. 10 (4.1 × 9.5 inches [105 × 241 mm]).

You can also load a single envelope in the rear paper feed slot, as described in that section.

**Note:** Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

**Note:** As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.
3. Pull on the front cover to pull out the lower paper cassette.

4. Slide the edge guides outward.

5. Insert up to 10 envelopes, printable side facedown and flap edge left, as shown.

**Note:** Make sure the envelope is not sticking out from the end of the cassette.
6. Slide the edge guides against the envelopes, but not too tightly.

Note: Make sure the envelopes are under the tabs on the edge guides.

7. Keep the cassette flat as you insert it.

Note: The output tray opens automatically when you print.

Always follow these envelope loading guidelines:

- If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one envelope at a time.
- Do not load envelopes that are curled, folded, or too thin.

Parent topic: Loading Paper

Related references
Paper Loading Capacity

Related tasks
Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
# Paper Loading Capacity

Load one sheet of paper or one envelope at a time in the rear paper feed slot. See the table here for the loading capacity of the paper cassettes.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Load up to this many sheets</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cassette 2 (lower cassette)</td>
</tr>
<tr>
<td>Plain paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm]), A4 (8.3 × 11.7 inches [210 × 297 mm]), or Legal (8.5 × 14 inches [216 × 357 mm]) size: 100 sheets</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>80 sheets</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>20 sheets</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>Load up to this many sheets</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Epson Premium Presentation</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Envelopes</td>
<td>10 envelopes</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper

Available Epson Papers

You can purchase genuine Epson ink and paper at Epson Supplies Central at [epson.com/ink3](http://epson.com/ink3) (U.S. sales) or [epson.ca](http://epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041809</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042038</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041141</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041649</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041271</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041156</td>
<td>20</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper</strong></td>
<td><strong>Glossy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041808</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041727</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042183</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S041667</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches (279 × 356 mm)</td>
<td>S041466</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041290</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041288</td>
<td>20</td>
</tr>
<tr>
<td><strong>Epson Ultra Premium Photo</strong></td>
<td><strong>Paper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Glossy</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S042181</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042174</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches (127 × 178 mm)</td>
<td>S041945</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041946</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042182</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042175</td>
<td>50</td>
</tr>
<tr>
<td><strong>Epson Ultra Premium Photo</strong></td>
<td><strong>Paper</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Luster</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041405</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041406</td>
<td>50</td>
</tr>
<tr>
<td><strong>Epson Premium Photo Paper</strong></td>
<td><strong>Semi-gloss</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 6 inches (102 × 152 mm)</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 × 14 inches [216 × 357 mm])</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 17 inches (279 × 432 mm)</td>
<td>S041070</td>
<td>100</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>8 × 10 inches (203 × 254 mm)</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S042180</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches (279 × 356 mm)</td>
<td>S041468</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041260</td>
<td>50</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches [297 × 420 mm])</td>
<td>S041343</td>
<td>50</td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S042384</td>
<td>150</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches [210 × 297 mm])</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041153</td>
<td>10</td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>S041636</td>
<td>20</td>
</tr>
<tr>
<td>Epson Scrapbook Photo Paper Matte Double-sided</td>
<td>Letter (8.5 × 11 inches [216 × 279 mm])</td>
<td>SCR1002</td>
<td>20</td>
</tr>
</tbody>
</table>

Parent topic: Loading Paper
Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

**Borderless Paper Types**
- Epson Photo Paper Glossy
- Epson Premium Photo Paper Glossy
- Epson Ultra Premium Photo Paper Glossy
- Epson Premium Photo Paper Semi-gloss
- Epson Ultra Premium Photo Paper Luster
- Epson Premium Presentation Paper Matte
- Epson Ultra Premium Presentation Paper Matte

**Borderless Paper Sizes**
- 3.5 × 5 inches (89 × 127 mm)
- 4 × 6 inches (102 × 152 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- Letter (8.5 × 11 inches [216 × 279 mm])
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A3 (11.7 × 16.5 inches [297 × 420 mm])
- 11 × 17 inches (279 × 432 mm)

**Parent topic:** Loading Paper
## Paper or Media Type Settings

<table>
<thead>
<tr>
<th>For this paper</th>
<th>Select this paper Type or Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Brochure &amp; Flyer Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Velvet Fine Art Paper</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelope</td>
</tr>
</tbody>
</table>

**Note:** The settings listed here are available only when printing from your computer; they do not apply to your product's control panel settings.

**Parent topic:** [Loading Paper](#)
Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

**Caution:** Do not place anything on top of your product or use its cover as a writing surface to avoid damaging it.

**Placing Originals on the Scanner Glass**

You can place originals up to this size on the scanner glass: Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]).

1. Open the document cover.

2. Place your original facedown on the scanner glass with the top of the original facing into the corner shown. Slide the original to the edges of the indicated corner.
Note: You can place multiple originals on the scanner glass. Just make sure they are at least 0.20 inch (5 mm) away from each other and from the edge of the scanner glass.

3. If you are copying two book pages onto one sheet, place the book as shown to copy the first page, then turn the book as shown to copy the second page.

4. Close the document cover gently to keep your original in place.

Parent topic: Placing Originals on the Product

Related topics
Copying
Scanning
Copying

See the information here to copy documents or photos using your product.

**Note:** Copies may not be exactly the same size as your originals.

**Copying Documents or Photos**

**Copying and Restoring Photos**

**Related tasks**

**Copying onto a CD/DVD**

### Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special papers.

1. Place your original document or photo on the scanner glass.
2. Load the paper you want to print on.

   **Note:** Load only the recommended number of sheets.

3. Select **Copy**.

4. To print more than one copy, press + or – to select the number (up to 99).
5. Select **Color** or **B&W**.

6. Scroll down to view and change additional copy settings, if necessary.

7. When you are ready to copy, press ⬤ start.

   **Note:** To cancel printing, select **Cancel**.

---

**Paper Type Settings - Copying**

Select a **Paper Type** setting that matches the paper you loaded.

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Matte</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
</tbody>
</table>
### Paper Type setting

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
</tbody>
</table>

### Paper Size Settings - Copying

Select the **Paper Size** setting that matches the paper you loaded.

**Note:** You can copy photos only on these paper sizes.

- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- Letter (8.5 × 11 inches [216 × 279 mm])
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- A3 (11.7 × 16.5 inches [297 × 420 mm])
- 11 × 17 inches (279 × 432 mm)

**Parent topic:** Copying Documents or Photos

### Copying Options

Select the copying options you want to use for your copies.

**Note:** Not all options or settings may be available, depending on other copying settings.

<table>
<thead>
<tr>
<th>Copying option</th>
<th>Available settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Density</td>
<td>Varying levels</td>
<td>Adjusts the lightness or darkness of copies</td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>2-Sided Copying</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1&gt;1-Sided</td>
<td>Uses the duplexer to make 2-sided copies</td>
</tr>
<tr>
<td></td>
<td>1&gt;2-Sided</td>
<td></td>
</tr>
<tr>
<td>Layout</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>With Border</td>
<td>Leaves a small margin around the image</td>
</tr>
<tr>
<td></td>
<td>Borderless</td>
<td>Expands the image to the edge of the paper (slight cropping may occur)</td>
</tr>
<tr>
<td></td>
<td>A4, 2-up Copy</td>
<td>Copies 2 originals onto a single A4-size sheet</td>
</tr>
<tr>
<td></td>
<td>Letter, 2-up Copy</td>
<td>Copies 2 originals onto a single letter-size sheet</td>
</tr>
<tr>
<td></td>
<td>A4, Book/2-up</td>
<td>Copies 2 pages of a book or magazine onto a single A4-size sheet</td>
</tr>
<tr>
<td></td>
<td>Letter, Book/2-up</td>
<td>Copies 2 pages of a book or magazine onto a single letter-size sheet</td>
</tr>
<tr>
<td></td>
<td>Book/2-sided</td>
<td>Copies 2 pages of a book or magazine onto both sides of a single sheet (only available when 1&gt;2-Sided is selected)</td>
</tr>
<tr>
<td>Reduce/Enlarge</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom Size</td>
<td>Automatically sizes the image by the percentage you select</td>
</tr>
<tr>
<td></td>
<td>Actual Size</td>
<td>Copies at 100% size</td>
</tr>
<tr>
<td></td>
<td>Auto Fit Page</td>
<td>Automatically sizes the image to fit the selected paper size setting</td>
</tr>
<tr>
<td></td>
<td>Letter-&gt;4x6in and other conversions</td>
<td>Automatically converts from one size to another</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Various sizes</td>
<td>Selects the paper size for the copy printout</td>
</tr>
<tr>
<td>Paper Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Plain Paper</td>
<td>Adjusts printer settings for the selected paper type</td>
</tr>
<tr>
<td></td>
<td>Matte</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Prem. Glossy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ultra Glossy</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Glossy</td>
<td></td>
</tr>
<tr>
<td>Copying option</td>
<td>Available settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Paper Source</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cassette 1</td>
<td></td>
<td>Copies onto paper loaded in Cassette 1 (upper cassette)</td>
</tr>
<tr>
<td>Cassette 2</td>
<td></td>
<td>Copies onto paper loaded in Cassette 2 (lower cassette)</td>
</tr>
<tr>
<td>Rear Paper Feed Slot</td>
<td></td>
<td>Copies onto paper loaded in the rear paper feed slot</td>
</tr>
<tr>
<td><strong>Document Type</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>Copies a text document</td>
</tr>
<tr>
<td>Text &amp; Image</td>
<td></td>
<td>Copies a document that includes text and images</td>
</tr>
<tr>
<td>Photo</td>
<td></td>
<td>Copies a photograph</td>
</tr>
<tr>
<td><strong>Quality</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Draft</td>
<td></td>
<td>Provides lower quality for draft copies (plain paper only)</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td>Provides good quality for most copies</td>
</tr>
<tr>
<td>Best</td>
<td></td>
<td>Provides the highest quality for special copies</td>
</tr>
<tr>
<td><strong>Document Orientation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portrait</td>
<td></td>
<td>Specifies the orientation of your originals (only available when 1&gt;2-Sided is selected)</td>
</tr>
<tr>
<td>Landscape</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Binding Margin</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Left Edge</td>
<td></td>
<td>Specifies the binding edge of your double-sided copies (only available when 1&gt;2-Sided is selected)</td>
</tr>
<tr>
<td>Top Edge</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Expansion</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td>Adjusts the amount of expansion for printing borderless photos</td>
</tr>
<tr>
<td>Medium</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minimum</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dry Time</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard</td>
<td></td>
<td>Provides longer drying time for 2-sided copies, if smudges or marks appear on the front of the paper when you print on the second side</td>
</tr>
<tr>
<td>Long</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Longer</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Clear All Settings</strong></td>
<td>—</td>
<td>Restores the copy settings to the default settings</td>
</tr>
</tbody>
</table>

**Parent topic:** Copying Documents or Photos
Copying and Restoring Photos

You can restore the colors in faded photos as you copy them.

1. Load photo paper in the product.
2. Press the home button, if necessary.
3. Select More Functions.
4. Select Copy/Restore Photos.

5. Select On.
6. Place up to two original photos on the product.

   Note: View the LCD screen for instructions on placing your photos on the product.

7. Press the start button.
8. Press + or – to select one or more copies of the photo (up to 99).
9. If you placed two originals on the scanner, press the left or right arrow button to view the second original, then press + or – to select one or more copies of the photo (up to 99).
10. To adjust your print and copy settings, do one or more of the following:
    • To change the print settings, select Settings, and select the necessary settings.
    • To adjust the copy image, select Edit > Photo Adjustments, then select your settings.
    • To add a B&W filter to the copy, select Edit > Filter, then select the B&W setting.
• To crop or zoom into your photo, select **Edit > Crop/Zoom**, then press the icons displayed on the LCD screen to crop your image.

11. When you are ready to print, press the start button.

   **Note:** To cancel printing, select **Cancel**.

**Parent topic:** Copying

**Related references**
- Available Epson Papers
- Paper Type Settings - Copying
- Paper Size Settings - Copying
- Copying Options

**Related tasks**
- Placing Originals on the Scanner Glass

**Related topics**
- Loading Paper
Printing From a Computer

Before printing from your computer, make sure you have set up your product and installed its software as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software on Epson's support website. If you see a Software Update screen, select Enable automatic checking and click OK. The update scans your system to see if you have the latest product software. Follow the on-screen instructions.

Printing with Windows
Printing with Mac OS X
Cancelling Printing Using a Product Button

Related tasks
Checking for Software Updates

Printing with Windows

You can print with your product using any Windows printing program, as described in these sections.

Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting a Printing Preset - Windows
Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options

Parent topic: Printing From a Computer

Selecting Basic Print Settings - Windows

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   **Note:** You may need to select a print icon on your screen, the **Print** option in the File menu, or another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.

   **Note:** You may also need to select **Properties** or **Preferences** to view your print settings.

You see the Main tab of your printer settings window:
4. Select the **Quality Option** setting that matches your print content and the print quality you want to use.

5. Select the **Source** setting that indicates where you loaded the paper or CD/DVD you want to print on.

6. Select the type of paper you loaded as the **Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

7. Select the size of the paper you loaded as the **Size** setting.

   **Note:** You can also select the **User Defined** setting to create a custom paper size.

8. Select one of the border options:
   - If you are printing a borderless photo, select **Borderless**.
     
     **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.
   - If you are printing a document or a photo with borders, select **Borders**.

9. Select the orientation of your document or photo as shown in the printer settings window.

   **Note:** If you are printing an envelope, select **Landscape**.

10. To print on both sides of the paper, select a **2-sided printing** option.

11. Select any of the available print options.

   **Note:** If you need to access the Epson product support website, click the **Online Support** button.
Related tasks
Selecting Double-sided Printing Settings - Windows

Paper Source Options - Windows
You can select any of the available options in the Paper Source menu to print on the paper loaded in that source.

**Auto Cassette Selection**
Automatically selects the paper source based on the selected paper size.

**Cassette 1**
Selects the paper in cassette 1 as the paper source.

**Cassette 2**
Selects the paper in cassette 2 as the paper source.

**Cassette 1 > Cassette 2**
Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when cassette 1 is empty.

**Rear Paper Feed Slot**
Selects the paper in the rear feed slot as the paper source.

**CD/DVD**
Selects the CD or DVD loaded as the source.

Parent topic: Selecting Basic Print Settings - Windows

Basic Print Options - Windows
You can select any of the basic print options to customize your print. Some options may be pre-selected or unavailable, depending on other settings you have chosen.

**Fix Photo**
Improves the color, contrast, and sharpness of flawed photos.

*Note:* Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

**Fix Red-Eye**
Reduces or removes red-eye in photos.

**Reverse Order**
Prints multi-page print jobs last page first.
Print Preview
Displays a preview of your printout before printing.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Advanced Print Settings - Windows
Select print settings on the Advanced tab to customize the quality and color settings for your printout, and save your own printing presets.

1. Click the Advanced tab.

You see the advanced print settings:
2. Select the **Paper & Quality Options** settings for your printout:
   - Select where you loaded the paper or CD/DVD you want to print on.
   - Select the type of paper you loaded.

   **Note:** Check the paper type settings list for details.

   - Select the print quality setting you want to use.

   **Note:** Check the print quality settings list for details.

   - Select the size of the paper you loaded.
   - Select **Borderless** to print a borderless photo, or **Borders** to print a document or a photo with borders.

   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

3. Select **Portrait** or **Landscape** as the orientation of your document or photo.

   **Note:** If you are printing an envelope, select **Landscape**.

4. Select any of the available advanced print options.

5. Select any of the available color management options, or turn off color management.

   **Advanced Print Quality Settings - Windows**
   **Advanced Print Options - Windows**
   **Color Management Options - Windows**

**Parent topic:** Printing with Windows

**Related references**

**Borderless Paper Type Compatibility**

**Paper or Media Type Settings**

**Paper Source Options - Windows**

**Related tasks**

**Selecting Double-sided Printing Settings - Windows**
Advanced Print Quality Settings - Windows

You can select any of the print quality settings to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

**Draft**
For draft printing on photo paper.

**Fast Economy**
For the fastest printing with draft quality.

**Economy**
For fast printing with reduced quality.

**Normal**
For everyday text and image printing.

**Fine**
For text and graphics with good quality and print speed.

**Photo**
For photos and graphics with good quality and print speed.

**Photo RPM**
For the best print quality, but the slowest print speed.

Parent topic: Selecting Advanced Print Settings - Windows

Advanced Print Options - Windows

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

**Fix Red-Eye**
Reduces or removes red-eye in photos.

**High Speed**
Speeds up printing, but may reduce print quality.

**Edge Smoothing**
Smoothes jagged edges in low-resolution images such as screen captures or images from the Web.

**Print Preview**
Displays a preview of your printout before printing.

**Black/Grayscale**
Prints text and graphics in black or shades of gray.

**Quiet Mode**
Lessens noise during printing but may decrease print speed.
Parent topic: Selecting Advanced Print Settings - Windows

Color Management Options - Windows

You can adjust the Color Management settings on the Advanced tab to fine-tune the colors in your printout, or turn off color management in your printer software.

Color Controls
Let you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and Density, and individual color tones. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

ICM
Lets you turn off color management in your printer software using the Off (No Color Adjustment) option. You can then manage color using only your application software.

Parent topic: Selecting Advanced Print Settings - Windows

Selecting Print Layout Options - Windows

You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.
• To change the size of your printed document or photo, select the Reduce/Enlarge Document checkbox and select sizing options.
• To print on both sides of your paper, select the 2-sided printing options.
• To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select the Multi-Page checkbox and select the options you want.
• To print multiple copies and arrange their print order, select the Copies options.
• To control printing at the edges of borderless images, select a **Borderless** option:

  **Note:** To make changes to the **Borderless** settings, you must have selected the **Borderless** option on the Advanced tab.

• To adjust the automatic settings, select **Auto Expand** as the Enlargement Method setting, then adjust the **Expansion** slider (if necessary) to control the amount of image expansion.

  **Note:** If you select the **Min** option for the Expansion setting, you may see white borders on your printed photo.

• To print the borderless image at its actual size without scaling, select **Retain Size** as the Enlargement Method setting.

• To add a watermark to your printout, select **Watermark** settings.

• To rotate or flip the printed image, select the **Rotate 180°** or **Mirror Image** checkboxes.

**Parent topic:** Printing with Windows

**Related tasks**

- Selecting Double-sided Printing Settings - Windows

**Selecting a Printing Preset - Windows**

For quick access to common groups of print settings, you can select a printing preset.

**Note:** You can create your own preset by clicking the **Save Settings** button on the Advanced tab.

1. Click the **Shortcuts** tab.
   
   You see the available Printing Presets options:
2. Place your cursor over a Printing Presets option to view its list of settings.
3. Use any of the available options on the screen to control your printing presets.
4. To choose an option for printing, select it.
5. Click OK.

Parent topic: Printing with Windows

Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-sided printing options on the Main or Page Layout tab. (Some options are not available on the Main tab.)

Automatic double-sided printing is only available if you have loaded plain paper in these sizes: Letter (8.5 × 11 inches [216 × 279 mm]) and A4 (8.3 × 11.7 inches [210 × 297 mm]).
Note: Some options may be unavailable, depending on other settings you have chosen.

1. Click the Page Layout tab.
2. Select one of the 2-sided printing options:
   - Select the Auto checkbox to automatically print your double-sided print job.
   - Select the Manual checkbox to print your double-sided print job manually by printing one side and flipping the paper over to print the other side (recommended for paper types that do not support automatic duplexing).
3. Select the Folded Booklet checkbox if you want to order the pages of your double-sided print to create a single-fold booklet.
4. Click the Settings button.
   You see this window:
5. Select the binding options you want to use.
6. Click OK to return to the Page Layout tab.
7. Click the Adjust Print Density button.
   You see this window:

![Print Density Adjustment window]

8. Select the type of document you are printing as the Document Type setting. The software automatically sets the Adjustments options for that document type.
9. If you selected the Manual document type, select the Adjustments options you want to use.
10. Click OK to return to the Page Layout tab.
11. Print a test copy of your double-sided document to test the selected settings.
12. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.

**Binding Edge Options**
Select a setting that orients double-sided print binding in the desired direction.

**Binding Margin Options**
Select options that define a wider margin to allow for binding.

**Booklet Option**
Select a binding option to use when creating a folded booklet.

**Parent topic:** Selecting Double-sided Printing Settings - Windows

Print Density Adjustments - Windows
You can select any of the available options on the Print Density Adjustment window to adjust the print quality of your double-sided print job.

**Print Density**
Sets the level of ink coverage for double-sided printing.

**Increased Ink Drying Time**
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing to prevent ink smearing.

**Parent topic:** Selecting Double-sided Printing Settings - Windows

**Printing Your Document or Photo - Windows**
Once you have selected your print settings, you are ready to save your settings and print.
1. Click **OK** to save your settings.
   
   You see your application’s Print window, such as this one:
2. Click **OK** or **Print** to start printing.

Checking Print Status - Windows

**Parent topic:** Printing with Windows

**Related tasks**
- Selecting Basic Print Settings - Windows
- Selecting Advanced Print Settings - Windows
- Selecting Print Layout Options - Windows

**Checking Print Status - Windows**

During printing, you see this window showing the progress of your print job. It allows you to control printing and check ink cartridge status.
• To cancel printing, click **Cancel**.
• To see print jobs lined up for printing, click **Print Queue**.
• To check ink status, click **Check Ink Levels**.

**Parent topic:** Printing Your Document or Photo - Windows

### Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that program session. If you want to change the print settings you use in all your Windows programs, you can select new default print settings.

1. Right-click the product icon in the Windows taskbar.
2. Select **Printer Settings**.
   
   You see the printer settings window:
3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click **OK**.
   
   These settings are now the defaults selected for printing. You can still change them as needed for printing in any program session.

**Changing the Language of the Printer Software Screens**

**Parent topic:** Printing with Windows

**Changing the Language of the Printer Software Screens**

You can change the language used on the Windows printer software screens.
1. Right-click the product icon in the Windows taskbar.
2. Select **Printer Settings**.  
   You see the printer settings window.

3. Click the **Maintenance** tab.  
   You see the maintenance options:

![Printing Preferences window](image)

4. Select the language you want to use as the **Language** setting.

5. Click **OK** to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.

**Parent topic:** Selecting Default Print Settings - Windows
Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can change how often the software checks for updates or disable this feature.

1. Right-click the product icon in the Windows taskbar.
2. Select **Software Update Settings**.
   
   You see this window:

   ![Software Update Settings](image)

3. Do one of the following:
   
   - To change how often the software checks for updates, select a setting in the **Check every** menu.
   - To disable the automatic update feature, select the **Never** option.

4. Click **OK** to exit.

   **Note:** If you choose to disable the automatic update feature, you can check for updates manually.

**Parent topic:** Printing with Windows

**Related tasks**

- Checking for Software Updates

**Printing with Mac OS X**

You can print with your product using any Mac OS X printing program, as described in these sections.
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X
Selecting Print Layout Options - Mac OS X
Selecting Double-sided Printing Settings - Mac OS X
Managing Color - Mac OS X
Selecting Printing Preferences - Mac OS X
Printing Your Document or Photo - Mac OS X

Parent topic: Printing From a Computer

Selecting Basic Print Settings - Mac OS X

Select the basic settings for the document or photo you want to print.

1. Open a photo or document for printing.
2. Select the print command in your application.

   Note: You may need to select a print icon on your screen, the Print option in the File menu, or another command. See your application's help utility for details.

3. Select your product as the Printer setting.

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the print window.
   You see the expanded printer settings window for your product:
5. Select the **Copies** and **Pages** settings as necessary.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing.

6. Select the page setup options: **Paper Size** and **Orientation**.

   **Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.
7. Select any application-specific settings that appear on the screen, such as those shown in the image above for the Preview application.

8. Select **Print Settings** from the pop-up menu.
9. Select the **Paper Source** you wish to print from.

10. Select the type of paper you loaded as the **Media Type** setting.

   **Note:** The setting may not exactly match the name of your paper. Check the paper type settings list for details.

11. Select the **Print Quality** setting you want to use.

12. Select any of the available print options.

   - **Paper Source Options - Mac OS X**
   - **Print Quality Settings - Mac OS X**
   - **Print Options - Mac OS X**

   **Parent topic:** Printing with Mac OS X

   **Related references**

   - Paper or Media Type Settings

   **Related tasks**

   - Selecting Page Setup Settings - Mac OS X
   - Printing Your Document or Photo - Windows

**Paper Source Options - Mac OS X**

You can select any of the available options in the Paper Source menu to print from paper loaded in that source.

- **Cassette 1**
  - Selects the paper in cassette 1 as the paper source.

- **Cassette 2**
  - Selects the paper in cassette 2 as the paper source.

- **Rear Paper Feed Slot**
  - Selects the paper in the rear feed slot as the paper source.

**Print Quality Settings - Mac OS X**

You can select any of the print quality settings to fine-tune the quality of your print. Some settings may be unavailable, depending on the paper type and border setting you have chosen.

- **Draft**
  - For draft printing on photo paper.
**Fast Economy**  
For the fastest printing with draft quality.

**Economy**  
For fast printing with reduced quality.

**Normal**  
For everyday text and image printing.

**Fine**  
For text and graphics with good quality and print speed.

**Photo**  
For photos and graphics with good quality and print speed.

**Photo RPM**  
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Mac OS X

**Print Options - Mac OS X**

You can select any of the print options to customize your print. Some options may be unavailable, depending on other settings you have chosen.

**Expansion**  
If you selected a borderless paper size setting, this option adjusts the image expansion settings to control printing at the edges of borderless prints.

**Grayscale**  
Prints text and graphics in black or shades of gray.

**Mirror Image**  
Lets you flip the printed image horizontally.

**Note:** If you select the Min option for the Expansion setting, you may see white borders on your printed photo.

Parent topic: Selecting Basic Print Settings - Mac OS X

**Selecting Page Setup Settings - Mac OS X**

Depending on your application, you may be able to select the paper size and orientation settings from the print window.
**Note:** If you do not see these settings in the print window, check for them in your application before printing. They may be accessible by selecting **Page Setup** from the File menu.

1. Select the size of the paper you loaded as the **Paper Size** setting. If you are printing a borderless photo, select the **Borderless** checkbox or a paper size with a **Borderless** option. You can also select a custom setting to create a custom paper size.

   **Note:** You must select a compatible borderless paper type and size to print without borders. Check the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

   **Note:** If you are printing an envelope, select the icon.

   **Note:** You can reduce or enlarge the size of the printed image by selecting **Paper Handling** from the pop-up menu and selecting a scaling option.

**Parent topic:** Printing with Mac OS X  
**Related references**

Borderless Paper Type Compatibility

**Selecting Print Layout Options - Mac OS X**

You can select a variety of layout options for your document or photo by selecting **Layout** from the pop-up menu on the print window.
• To print multiple pages on one sheet of paper, select the number of pages in the **Pages per Sheet** pop-up menu. To arrange the print order of the pages, select a **Layout Direction** setting.

• To print borders around each page on the sheet, select a line setting from the **Border** pop-up menu.

• To invert or flip the printed image, select the **Reverse page orientation** or **Flip horizontally** settings.

**Parent topic:** [Printing with Mac OS X](#)

### Selecting Double-sided Printing Settings - Mac OS X

You can print on both sides of the paper by selecting **Two-sided Printing Settings** from the pop-up menu on the print window.
Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen or if you are accessing the product over a network. This screen may be different, depending on the version of Mac OS X you are using.

1. Select one of the Two-sided Printing options.
2. Select the type of document you are printing as the **Document Type** setting. The software automatically sets the Adjustments options for that document type.

3. If necessary, customize the Adjustments settings as instructed on the screen.

4. Print a test copy of your double-sided document to test the selected settings.

5. Follow any instructions displayed on the screen during printing.

**Double-sided Printing Options and Adjustments - Mac OS X**

**Parent topic:** Printing with Mac OS X

**Double-sided Printing Options and Adjustments - Mac OS X**

You can select any of the available options in the **Two-sided Printing Settings** or **Output Settings** pop-up menu to set up your double-sided print job.

**Two-sided Printing Options**

**Long-Edge binding**

Orients double-sided printed pages to be bound on the long edge of the paper.
**Short-Edge binding**  
Orients double-sided printed pages to be bound on the short edge of the paper.

**Adjustments**

**Print Density**  
Sets the level of ink coverage for double-sided printing.

**Increased Ink Drying Time**  
Sets the amount of time required for drying ink after printing on one side of the paper before printing the other side in double-sided printing.

**Parent topic:** Selecting Double-sided Printing Settings - Mac OS X

### Managing Color - Mac OS X

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or turn off color management in your printer software.

1. Select **Color Matching** from the pop-up menu in the print window.

![Color Matching](image)

2. Select one of the available options.
3. Select **Color Options** from the pop-up menu in the print window.

![Color Options menu](image)

**Note:** The available settings on the Color Options menu depend on the option you selected on the Color Matching menu.

4. Select one of the available options.

**Color Matching and Color Options - Mac OS X**

**Parent topic:** Printing with Mac OS X

**Color Matching and Color Options - Mac OS X**

You can select from these settings on the **Color Matching** and **Color Options** menus.

**Color Matching Settings**

**EPSON Color Controls**

Lets you manage color using controls in your printer software, or turn off color management.

**ColorSync**

Prints using standard color profiles for your product and paper to help match image colors. You can customize the conversion method and filter settings on the ColorSync pop-up menu in the print window.
Color Options Settings

Manual Settings
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-eye in photos. Depending on the selected color mode, you can also adjust the midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your application software.

Selecting Printing Preferences - Mac OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. In the Apple menu or the Dock, select System Preferences.
2. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies.
3. Select Driver.
   You see this screen:
4. Select any of the available printing preferences.
5. Click OK.

**Printing Preferences - Mac OS X**

**Parent topic:** Printing with Mac OS X

**Printing Preferences - Mac OS X**

You can select from these settings on the Driver tab.

**Thick paper and envelopes**
Prevents ink from smearing when you print on envelopes or other thick paper.

**Skip Blank Page**
Ensures that your product does not print pages that contain no text or images.

**Quiet Mode**
Lessens noise during printing but may decrease print speed.

**Permit temporary black printing**
Allows you to print using black ink when a color ink cartridge is expended.

**Automatic Cassette Switching**
Automatically switches to the other cassette when one of the cassettes runs out of paper.
**High Speed Printing**
Speeds up printing, but may reduce print quality.

**Warning Notifications**
Lets you choose whether or not to receive warning notifications from the printer software when ink is low.

**Establish bidirectional communication**
Allows the product to communicate with the computer. Do not change the default setting **On** unless you experience issues when using a shared printing pool.

**Parent topic:** Selecting Printing Preferences - Mac OS X

### Printing Your Document or Photo - Mac OS X

Once you have selected your print settings, you are ready to print.

Click **Print** at the bottom of the print window.

![Print settings dialog box](image)

**Checking Print Status - Mac OS X**

**Parent topic:** Printing with Mac OS X
Checking Print Status - Mac OS X

During printing, you can view the progress of your print job, control printing, and check ink cartridge status.

1. Click the printer icon when it appears in the Dock.
   You see the print status window:

2. Select the following options as necessary:

   **Mac OS X 10.5/10.6/10.7:**
   - To cancel printing, click the print job and click the **Delete** icon.
   - To pause a print job, click the print job and click the **Hold** icon. To resume a print job, click the print job marked "Hold" and click the **Resume** icon.
   - To pause printing for all queued print jobs, click the **Pause Printer** icon.
   - To check ink status, click the **Supply Levels** icon.

   **Mac OS X 10.8:**
   - To cancel printing, click the **X** button next to the print job.
   - To pause a print job, click the **P** button next to the print job. To resume a print job, click the **P** button.
   - To pause printing for all queued print jobs, click the large **Pause** button.
   - To check ink status, click the **Settings** icon, then click the **Supply Levels** tab.

**Parent topic:** Printing Your Document or Photo - Mac OS X
Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD display.

Parent topic: Printing From a Computer
Scanning

You can scan original documents or photos and save them as digital files.

Starting a Scan
Selecting Epson Scan Settings
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Scanning Special Projects

Starting a Scan

After placing your original documents or photos on your product for scanning, start scanning using one of these methods.

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan Icon
Starting a Scan from a Scanning Program

Parent topic: Scanning

Related tasks
Placing Originals on the Scanner Glass

Starting a Scan Using the Product Control Panel

You can scan an image to your computer using your product's touch panel buttons.

Your product automatically selects suitable default scan settings, but you can view or change them as necessary.

1. Make sure you installed the product software and connected the product to your computer or network.
2. Press the home button, if necessary.
3. Select Scan.
   The scan options are displayed:
4. Scroll up or down to view additional scan options, then select the one you want.
   - **Scan to Memory Card** saves your scan file on a memory card and lets you select the file format, quality, and other settings.
   - **Scan to Cloud** sends your scanned files to a destination that you have registered with Epson Connect.

   **Note:** To use this feature, you must have registered a cloud account with Epson Connect.

   - **Scan to PC (JPEG)** saves your scan file directly to your computer or as an image capture in Mac OS X 10.6/10.7/10.8.
   - **Scan to PC (PDF)** saves your scan as a PDF file to your computer or as an image capture in Mac OS X 10.6/10.7/10.8.
   - **Scan to PC (Email)** scans your original and attaches it to a message in your e-mail program. You can select the e-mail program you want to use and resize your image, if necessary, from an option screen on your computer.

   **Note:** This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail, and Entourage, but not web-based email such as Gmail.

   - **Scan to PC (WSD)** lets you manage wireless scanning in Windows 8, Windows 7, or Windows Vista (English only).
**Note:** To use this feature, you must first set up WSD (Web Services for Devices) on the computer you want to scan to.

5. To scan to your PC, select how you connected your product to your computer:
   - If your product is connected directly to your computer with a USB cable, select **USB Connection**.
   - If your product is connected to your computer over a network, select the computer name from the list.

6. Press the ⬤ start button to start scanning.

---

**Scan to Memory Card Options**

Select the **Scan to Memory Card** options you want to use.

<table>
<thead>
<tr>
<th>Scan to Memory Card setting</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPG</td>
<td>—</td>
<td>JPG: for photos</td>
</tr>
<tr>
<td>PDF</td>
<td>—</td>
<td>PDF: for documents</td>
</tr>
<tr>
<td>Color</td>
<td>—</td>
<td>Select color or black-and-white scans</td>
</tr>
<tr>
<td>B&amp;W</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>Contrast</td>
<td>Various levels</td>
<td>Decrease or increase image contrast</td>
</tr>
<tr>
<td>Scan Area</td>
<td>Letter</td>
<td>Selects the page size for documents or special settings for photos.</td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td><strong>Auto Cropping</strong>: for photos with dark edges</td>
</tr>
<tr>
<td></td>
<td>Auto Cropping</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Max Area</td>
<td><strong>Max Area</strong>: for most photos</td>
</tr>
<tr>
<td>Document</td>
<td>Text</td>
<td>Selects the type of original you are scanning</td>
</tr>
<tr>
<td></td>
<td>Photograph</td>
<td></td>
</tr>
</tbody>
</table>
### Changing Default Scan Button Settings

You can view or change the default scan settings your product uses when you scan to your computer using the product buttons. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:
   - **Windows 8**: Navigate to the Start screen and select Event Manager.
   - **Windows (other versions)**: Click or Start > All Programs or Programs > EPSON Software > Event Manager.
   - **Mac OS X**: Open the Applications folder, click Epson Software, and click Event Manager.
2. Open the Scanner (Windows) or Select Scanner (Mac OS X) drop-down list and select your product, if necessary.
3. Click Make Job Settings.
4. Open the Edit Job Settings drop-down list and select the scan button settings you want to view or change.
5. Change the settings as necessary.
6. Click OK.
7. Click Close to close the Event Manager window.

Parent topic: Starting a Scan Using the Product Control Panel

### Starting a Scan Using the Epson Scan Icon

You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a file.
• **Windows**: Double-click the **EPSON Scan** icon on your computer desktop.

• **Mac OS X**: Open the **Applications** folder, open the **Epson Software** folder, and double-click the **EPSON Scan** icon.

**Note**: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site ([U.S. downloads](https://www.epson.com) or [Canadian downloads](https://www.epson.ca)).

You see an Epson Scan window like this:
Parent topic: Starting a Scan

Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Related topics
Selecting Epson Scan Settings
Starting a Scan from a Scanning Program

You can start Epson Scan from a scanning program to select scan settings, scan, and open the scanned image in the program.

**Note:** With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site ([U.S. downloads](http://www.epson.com) or [Canadian downloads](http://www.epson.ca)).

1. Open your scanning program and select its scanning option. (See your scanning program help for instructions.)
2. Select your product.

   **Note:** In certain programs, you may need to select your product as the "source" first. If you see a **Select Source** option, choose it and select your product. With Windows, do not select a **WIA** option for your product; it will not work correctly.

You see an Epson Scan window like this:
Note: In certain programs, you may see the program's scan window instead of the Epson Scan window. Select scanning options as necessary.

Parent topic: Starting a Scan

Selecting Epson Scan Settings

After starting Epson Scan, you can select settings in various modes to customize your scan.

Scan Modes
Scan Modes

Epson Scan provides a choice of scan modes with different levels of control over your settings.

**Full Auto Mode**
This mode automatically detects the type of content you are scanning, selects settings for it, and saves your scanned image. You can also select various image adjustment options.

**Home Mode**
You can select setting groups based on the type of content you are scanning. You can also select various image adjustment options, and preview and size your scanned image.

**Office Mode**
You can quickly scan text documents and adjust them on a preview screen. You can also select various image adjustment options and preview your scanned image.

**Professional Mode**
You can manually customize all available settings, and preview and size your scanned image.

Parent topic: Scanning

Related tasks

Selecting the Scan Mode

Selecting the Scan Mode

Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson Scan window:
When you scan in Full Auto Mode, Epson Scan automatically saves your scanned file in JPEG format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can change the scanned file settings and select various image adjustment options before you scan, if necessary.

1. Start Epson Scan and select **Full Auto Mode** as the Mode setting.
   
   You see this window:
To scan in Full Auto Mode, position or load the material you want to scan, then click Scan.

For Color Restoration and other options, click the Customize button and then make the settings.

You can change the scan mode in the Mode list box at the top right of the window.
2. To select image adjustment options or change your scanned file settings, click **Customize**, select the settings, and click **OK**.

   ![Customize dialog box](image)

   - To choose any of the available image adjustment options, select the checkbox for the option.
   - To change the scanned file settings, click **File Save Settings**.

3. Click **Scan**.

   Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the image, if desired.

   Available Image Adjustments - Full Auto Mode

   **Parent topic:** Selecting Epson Scan Settings
Available Image Adjustments - Full Auto Mode

You can select these image adjustment options in Epson Scan Full Auto Mode.

**Dust Removal**  
Removes dust marks from your originals automatically.

**Color Restoration**  
Restores the colors in faded photos automatically.

**Auto Photo Orientation**  
Checks the preview image for faces, the sky, and other features, and then correctly rotates the photo when it is scanned, if necessary. (If your photo is not oriented correctly using this option, deselect this option and scan again.)

Parent topic: Scanning in Full Auto Mode

Scanning in Home Mode

When you scan in Home Mode, Epson Scan automatically saves your scanned file in JPEG format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select **Home Mode** as the Mode setting.
   
   You see this window:
2. Select the **Document Type** setting that matches your original, such as Photograph or Text/Line Art.

3. Select the **Image Type** setting that matches your original.
4. Select the way you plan to use your scanned image as the **Destination** setting. (The Resolution setting is selected automatically based on the Destination setting you choose.)
   - **Screen/Web**: Select this option for images you will email, view on a computer screen, or post on the web.
   - **Printer**: Select this option for images you will print or documents you will convert to editable text using OCR (Optical Character Recognition) software.
   - **Other**: Select this option if you want to select a custom resolution for your image.
5. If you selected **Other** in the last step, select the **Resolution** setting you want to use for your scan.
6. Click the **Preview** button.
   - Epson Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).
8. Select any of the image adjustment settings you want to use. Before making adjustments, click the image or scan area in the Preview window.
9. If you want to reduce or enlarge your image as you scan, select the **Target Size** setting you want to use.
10. Click **Scan**.
    - You see the File Save Settings window.
11. Change any of the necessary file save settings and click **OK**.
   - Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the image, if desired.

**Parent topic:** Selecting Epson Scan Settings

**Related concepts**

- Image Preview Guidelines
- Scan Resolution Guidelines

**Related tasks**

- Selecting Scan File Settings
Selecting a Scan Area - Home Mode

You can select a specific area in your preview image to include in your scanned image. You can select the entire image area or a portion of it. You can even select multiple scan areas to create multiple scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just be sure to click inside the scan area before selecting the settings.

1. Do one of the following to select your scan area in the Preview image:
   - **Thumbnail preview**: Your scan area is selected automatically, but you can change it. Place your cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner to create a marquee (dotted line) on the preview image.
- **Normal preview**: Click the Auto Locate icon to create a marquee (dotted line) on the preview image.
2. Do the following, as necessary, to work with the selected scan area:
   • If the marquee is correct, continue with the next step.
   • To move the marquee, click inside the scan area and drag the marquee where you want it.
   • To resize the scan area, place your cursor over the edge or corner of the marquee, then click and drag the edges where you want them. (Hold down the Shift key as you resize the marquee to retain the same width/height proportions.)
• **Normal preview**: To create additional marquees (up to 50), click the Copy Marquee icon to copy the existing marquee and paste it on the preview image.

  **Note**: If you draw multiple marquees, make sure you select the **All** button in the Preview window before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

  • To delete a marquee, click the marquee, then click the Delete Marquee icon.

  3. Click inside the scan area and make any necessary settings in the Epson Scan window.

  **Parent topic**: Scanning in Home Mode

**Available Image Adjustments - Home Mode**

You can select these Image Adjustments options in Epson Scan Home Mode.

![Image Adjustments](image)

**Note**: Select the **Image Option** checkbox if you need to set any of the grayed-out image adjustments. Not all adjustment settings may be available, depending on the Document Type and Image Type setting. Click the **Brightness** button to access additional settings.

**Descreening**

Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

**Color Restoration**

Restores the colors in faded photos automatically.

**Backlight Correction**

Removes shadows from photos that have too much background light.
Dust Removal
Removes dust marks from your originals automatically.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the graphics.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Home Mode

Selecting a Scan Size - Home Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size, such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. In the Epson Scan window, select the size you want your scanned image to be from the Target Size list.

   ![Target Size](image)

   **Note:** If you need to rotate the orientation of the target size for your image, click the Orientation icon.

   A marquee (dotted line) appears on your preview image proportioned for the size you selected.
3. Do the following, as necessary, to work with the selected scan area:
   • To move the marquee, click inside the scan area and drag the marquee where you want it.
   • To resize the scan area, place your cursor over the edge or corner of the marquee, then click and drag the edge where you want it.

   **Note:** Manually adjusting the marquee will not change the target size of the scanned file. The marquee only indicates the area of the image that will be scanned.
4. To create a scanned image size that is not available in the Target Size list, click the **Customize** option.

![Target Size dialog box](image)

5. Name the custom size, enter the size, click **Save**, and click **OK**. Then create a scan area on the preview image.

   The marquee is automatically proportioned for your custom scan size.

**Parent topic:** [Scanning in Home Mode](#)

**Scanning in Office Mode**

When you scan in Office Mode, Epson Scan automatically saves your scanned file in JPEG format in your operating system’s Pictures or My Pictures folder, or opens it in your scanning program. You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select **Office Mode** as the Mode setting.

   You see this window:
2. Select the **Image Type** setting that matches your original.
3. Select the **Document Source** setting indicating where you placed your original.
4. Select the **Size** and **Orientation** settings that match your original.
5. Select the **Resolution** setting you want to use for your scan.
6. Click the **Preview** button.
Epson Scan previews your original and displays the result in a separate Preview window.

7. If desired, select the area in your preview image that you want to scan (scan area).

8. Select any of the image adjustment settings you want to use. Before making adjustments, click the image or scan area in the Preview window.

9. Click **Scan**.

   You see the File Save Settings window.

10. Change any of the necessary file save settings and click **OK**.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the image, if desired.

**Selecting a Scan Area - Office Mode**

**Available Image Adjustments - Office Mode**

**Parent topic:** Selecting Epson Scan Settings

**Related concepts**

- Image Preview Guidelines
- Scan Resolution Guidelines

**Related tasks**

- Selecting Scan File Settings

### Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select the entire image area or a portion of it. You can even select multiple scan areas to create multiple scanned images of different areas.

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just be sure to click inside the scan area before selecting the settings.
1. In the Preview window, click the Auto Locate icon to create a marquee (dotted line) on the preview image.

2. Do the following, as necessary, to work with the selected scan area:
   • If the marquee is correct, continue with the next step.
   • To move the marquee, click inside the scan area and drag the marquee where you want it.
• To resize the scan area, place your cursor over the edge or corner of the marquee, then click and drag the edges where you want them. (Hold down the **Shift** key as you resize the marquee to retain the same width/height proportions.)

• To create additional marquees (up to 50, if available), click the Copy Marquee icon to copy the existing marquee and paste it on the preview image.

  **Note:** If you draw multiple marquees, make sure you select the **All** button in the Preview window before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.

3. Click inside each scan area and make any necessary settings in the Epson Scan window.

**Parent topic:** Scanning in Office Mode

### Available Image Adjustments - Office Mode

You can select these Image Adjustments options in Epson Scan Office Mode.

<table>
<thead>
<tr>
<th>Image Adjustments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unsharp Mask</td>
</tr>
<tr>
<td>Descreening</td>
</tr>
<tr>
<td>Image Option</td>
</tr>
<tr>
<td>Text Enhancement</td>
</tr>
<tr>
<td>Auto Area Segmentation</td>
</tr>
<tr>
<td>Color Enhance: Red</td>
</tr>
<tr>
<td>Brightness:</td>
</tr>
<tr>
<td>Contrast:</td>
</tr>
</tbody>
</table>

**Note:** Select the **Image Option** checkbox if you need to set any of the grayed-out image adjustments. Not all adjustment settings may be available, depending on the Image Type setting.

**Unsharp Mask**

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
**Descreening**
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

**Text Enhancement**
Sharpens the appearance of letters in text documents.

**Auto Area Segmentation**
Makes grayscale images clearer and text recognition more accurate by separating the text from the graphics.

**Color Enhance**
Enhances the red, green, or blue shades in the scanned image.

**Brightness**
Adjusts the overall lightness and darkness of the scanned image.

**Contrast**
Adjusts the difference between the light and dark areas of the overall scanned image.

**Threshold**
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

**Scanning in Professional Mode**

When you scan in Professional Mode, Epson Scan automatically saves your scanned file in JPEG format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select **Professional Mode** as the Mode setting.
   
   You see this window:
2. Select the **Document Type** setting that matches your original, such as **Reflective** for documents or photos.
3. Select the **Document Source** setting indicating where you placed your original.
4. Select the specific type of original you are scanning as the **Auto Exposure Type** setting: **Document** or **Photo**.
5. Select the details of your original and how you want it scanned as the **Image Type** setting.
6. Select the **Resolution** setting you want to use for your scan.
7. Click the **Preview** button.
   Epson Scan previews your original and displays the result in a separate Preview window.
8. If desired, select the area in your preview image that you want to scan (scan area).
9. Select any of the image adjustment settings you want to use. Before making adjustments, click the image or scan area in the Preview window.
10. If you want to reduce or enlarge your image as you scan, select the **Target Size** setting you want to use.
11. Click **Scan**.
   You see the File Save Settings window.
12. Change any of the necessary file save settings and click **OK**.
Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the image, if desired.

**Available Image Types - Professional Mode**
**Selecting a Scan Area - Professional Mode**
**Available Image Adjustments - Professional Mode**
**Selecting a Scan Size - Professional Mode**

**Parent topic:** Selecting Epson Scan Settings

**Related concepts**
**Image Preview Guidelines**
**Scan Resolution Guidelines**

**Related tasks**
**Selecting Scan File Settings**
Available Image Types - Professional Mode

You can select these Image Type options in Epson Scan Professional Mode.

- **24-bit Color**
  Select this setting for color photos.

- **Color Smoothing**
  Select this setting for color graphic images, such as charts or graphs.

- **8-bit Grayscale**
  Select this setting for black-and-white photos.

- **Black & White**
  Select this setting for black text documents or line art.

Parent topic: Scanning in Professional Mode

Selecting a Scan Area - Professional Mode

You can select a specific area in your preview image to include in your scanned image. You can select the entire image area or a portion of it. You can even select multiple scan areas to create multiple scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just be sure to click inside the scan area before selecting the settings.

**Note:** In Professional Mode, the default Preview mode is Normal mode. To use Thumbnail Preview mode instead, select the Thumbnail checkbox beneath the Preview button (if available), then click the Preview button to preview your image again.

1. Do one of the following to select your scan area in the Preview image:

   - **Normal preview:** Click the Auto Locate icon to create a marquee (dotted line) on the preview image.
• **Thumbnail preview**: Your scan area is selected automatically, but you can change it. Place your cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner to create a marquee (dotted line) on the preview image.
2. Do the following, as necessary, to work with the selected scan area:
   • If the marquee is correct, continue with the next step.
   • To move the marquee, click inside the scan area and drag the marquee where you want it.
   • To resize the scan area, place your cursor over the edge or corner of the marquee, then click and drag the edges where you want them. (Hold down the **Shift** key as you resize the marquee to retain the same width/height proportions.)
• **Normal preview:** To create additional marquees (up to 50, if available), click the Copy Marquee icon to copy the existing marquee and paste it on the preview image.

• To delete a marquee, click the marquee, then click the Delete Marquee icon.

**Note:** If you draw multiple marquees, make sure you select the **All** button in the Preview window before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.

**Parent topic:** Scanning in Professional Mode

**Available Image Adjustments - Professional Mode**

You can select these Adjustments options in Epson Scan Professional Mode.

![Adjustments](image)

**Note:** Not all adjustment settings may be available, depending on the Image Type setting.

Click the image adjustment icon to access additional settings.

Click the + (Windows) or ▶ (Mac OS X) icon next to a setting to change the level of adjustment.

**Unsharp Mask**

Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
**Descreening**
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

**Color Restoration**
Restores the colors in faded photos automatically.

**Backlight Correction**
Removes shadows from photos that have too much background light.

**Dust Removal**
Removes dust marks from your originals automatically.

**Auto Exposure**
Automatically adjusts the image exposure settings when you click the **Auto Exposure** icon. To automatically adjust image exposure settings continuously, click the **Configuration** button, click the **Color** tab, and select **Continuous auto exposure**. You can adjust the level of auto exposure using a slider.

**Histogram Adjustment**
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For advanced users only.) Click the **histogram** icon to access the settings.

**Tone Correction**
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click the **tone correction** icon to access the settings.

**Brightness**
Adjusts the overall lightness and darkness of the scanned image.

**Contrast**
Adjusts the difference between the light and dark areas of the overall scanned image.

**Saturation**
Adjusts the density of colors in the overall image.

**Color Balance**
Adjusts the balance of colors in the overall image.

**Color Palette**
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the highlight and shadow areas of the image. (For advanced users only.) Click the **Color Palette** icon to access the settings.
Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode

Selecting a Scan Size - Professional Mode
You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size, such as a common photo size like 4 × 6 inches (102 × 152 mm). This places a scan area of that size on the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.
2. In the Epson Scan window, select the size you want your scanned image to be from the Target Size list.

![Target Size: 5x7 in.](image)

**Note:** If you need to rotate the orientation of the target size for your image, click the orientation icon.

A marquee (dotted line) appears on your preview image proportioned for the size you selected.
3. Do the following, as necessary, to work with the selected scan area:
   • To move the marquee, click inside the scan area and drag the marquee where you want it.
   • To resize the scan area, place your cursor over the edge or corner of the marquee, then click and drag the edge where you want it.

   **Note:** Manually adjusting the marquee will not change the target size of the scanned file. The marquee only indicates the area of the image that will be scanned.
4. To create a scanned image size that is not available in the Target Size list, click the **Customize** option.

![Target Size dialog box]

5. Name the custom size, enter the size, click **Save**, and click **OK**. Then create a scan area on the preview image.

   The marquee is automatically proportioned for your custom scan size.

6. To use additional sizing tools, click the + (Windows) or ▶ (Mac OS X) icon next to the Target Size setting and select options as desired.

   ![Additional sizing tools]

   - **Scale**: Reduces or enlarges your image by the percentage you enter.
• **Trimming**: Turns automatic image cropping on or off.

• Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust it without constraint.

**Parent topic**: Scanning in Professional Mode

## Image Preview Guidelines

You can preview your scanned image so you can adjust the scan settings using the preview as a guide. There are two types of preview available, depending on the scan mode and selected settings:

**Thumbnail preview**
A thumbnail preview displays your previewed images as thumbnails with the scanned image area and exposure automatically selected. If the Thumbnail checkbox is selected, clicking the Preview button opens a thumbnail preview.

**Normal preview**
A normal preview displays your previewed images in their entirety so you can select the scanned image area and other settings manually. If the Thumbnail checkbox is deselected, clicking the Preview button opens a normal preview.

**Parent topic**: Selecting Epson Scan Settings

## Scan Resolution Guidelines

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the resolution setting you need:

• You will enlarge the image as you scan it.
  
  If you will enlarge the image using Epson Scan's Target Size setting (Home and Professional modes only), you do not need to increase the Resolution setting.

• You will scan the image at its original size, but enlarge it later in an image-editing program.
  
  Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

• You will scan the image at 100% or smaller size.
  
  Select Epson Scan's Resolution setting based on how you will use the scanned image:
  
  • E-mail/view on a computer screen/post on the web: 96 to 150 dpi
  
  • Print/convert to editable text (OCR): 300 dpi
Selecting Scan File Settings

You can select the location, name, and format of your scan file on the File Save Settings window. You can also select various optional settings that control how Epson Scan behaves when you scan and save files.

The File Save Settings window may appear after you click **Scan** on the Epson Scan window. You may also be able to access the window by clicking the icon on the Epson Scan window.
1. Do one of the following to select the folder in which you want to save your scanned image:
   • Click the button for one of the displayed folders.
   • Click the Other button, click the Browse or Choose button, and select a folder.
2. Type in a stem file name in the Prefix field. This name is used along with numbers to automatically name your scanned files.
3. Select a different number as the Start Number setting, if you like.
4. Select the file format you want to use in the Image Format Type menu.
5. If your file format provides optional settings, click the Options button to select them.
6. Choose any of the optional settings you want to use by selecting their checkboxes.
7. Click OK.

Available Scanned File Types and Optional Settings

You can select from a variety scanned file types and optional settings on the File Save Settings window in Epson Scan.

File Formats

Bitmap (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the lower the image quality. (The Tiff format is recommended when you need to modify or retouch your scanned image.)

Multi-TIFF (*.tif)
A Tiff file format when multiple pages are saved to the same file, allowing you to edit the images using a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac OS X systems using Adobe Reader, Acrobat, or other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most Mac OS X programs.

Parent topic: Selecting Epson Scan Settings
PRINT Image Matching II (*.jpg or *.tif)
File formats that include Epson PRINT Image Matching II data for enhanced quality and a wider color range (does not affect the way the image displays on the screen).

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP software.

Optional Settings

Overwrite any files with the same name
Select to overwrite previous files with the same names.

Show this dialog box before next scan
Select to have the File Save Settings window appear automatically before you scan.

Open image folder after scanning
Select to have Windows Explorer or Mac OS X Finder automatically open to the folder where your scanned image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-Tiff format, select to display a prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
With Mac OS X 10.6/10.7/10.8, you can scan with your product using an image-editing application such as Image Capture.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

1. Open an image editing application, such as Image Capture.
2. Select your Epson product from the DEVICES or SHARED list, if necessary.
3. If you see the Show Details button, click it.
   If you are scanning an item on the scanner glass, your product begins a preview scan.
4. Select the **Scan Mode** setting indicating where you placed your original (if available). Select any other scan settings as necessary.

5. Select the folder in which you want to save your scanned file in the **Scan To** pop-up menu.
6. Click **Scan**.
   Your scanned file is saved in the folder you selected.

**Available Scan Settings - Mac OS X Image Capture**

**Parent topic:** Scanning

**Available Scan Settings - Mac OS X Image Capture**

You can select these scan settings in your imaging editing application for Mac OS X.

**Unsharp Mask**
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

**Descreening**
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This option improves results when scanning magazines or newspapers. (The results of descreening do not appear in the preview image, only in your scanned image.)

**Backlight Correction**
Removes shadows from photos that have too much background light.

**Dust Removal**
Removes dust marks from your originals automatically.

**Color Restoration**
Restores the colors in faded photos automatically.

**Parent topic:** Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

**Scanning Special Projects**

Your product's scanning software offers various options to help you quickly complete special scan projects.

**Scanning to a PDF File**

**Restoring Photo Colors as You Scan**

**Parent topic:** Scanning

**Scanning to a PDF File**

Using Epson Scan, you can scan a multi-page document and save it in one PDF (Portable Document Format) file on your computer.

1. Place your original on your product for scanning.
2. Start Epson Scan.
3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. When you finish selecting all your settings, click **Scan**.
   You see the File Save Settings window.

![File Save Settings window](image)

7. Select **PDF** as the Type setting.
8. Select any other settings you want to use on the File Save Settings window. Click the **Options** button to access additional settings.

9. Click **OK**.

Epson Scan scans your document and you see this window:

![Add Page Confirmation](image)

10. Choose one of the following options on the screen:
   - If you are scanning only one page, click **Save File**.
   - If you need to scan additional pages in a document, click **Add page**. Place additional pages on the product for scanning, click **Scan**, and repeat until you have scanned all the pages. When you are finished, click **Save File**.
   - If you need to delete or reorder the scanned pages, click **Edit page**. Delete or reorder the pages using the icons that appear on the bottom of the editing window. When you are finished, click **OK**.

   **Note:** If you installed an OCR (Optical Character Recognition) program, you may see a screen indicating the program is converting your page to text. Wait until the program re-scans the page and close the program, if necessary.

11. Click **Close** to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the PDF file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the document, if desired.
Restoring Photo Colors as You Scan

You can restore the colors in faded photos as you scan them using Epson Scan's Color Restoration setting. You can select this setting in any of the available scan modes.

**Note:** Color restoration is not available in Office Mode, if Epson Scan offers that mode.

1. Place your original on your product for scanning.
2. Start Epson Scan.
3. Select the scan mode you want to use.
4. Select the scan settings for your scan.
5. Preview your image.
6. Locate or access the image adjustment settings.
7. Select the **Color Restoration** checkbox.

8. When you finish selecting all your settings, click **Scan**.
9. Click **Close** to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the color-restored file in the selected folder or opens it in your scanning program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac OS X Finder, where you can view and print the image, if desired.

Parent topic: Scanning Special Projects

Related tasks

- Starting a Scan Using the Epson Scan Icon
- Selecting the Scan Mode
- Selecting Scan File Settings
Placing Originals on the Scanner Glass

Related topics
Selecting Epson Scan Settings
Using Memory Cards With Your Product

Follow the instructions here to work with a memory card inserted into your product.

Inserting a Memory Card
Printing from a Memory Card
Transferring Photos on a Memory Card

Inserting a Memory Card

Insert only one memory card at a time into a memory card slot on your product.

1. Make sure the memory card and the files on it are compatible with your product before inserting the card.

2. Open the cover and insert your memory card into the correct slot, making sure the card is oriented correctly.

   1 Memory card access light

   Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.

   The memory card access light flashes and then stays lit.
Caution: Do not remove a memory card or turn off your product while the memory card access light is flashing or you may lose data from the memory card.

Memory Card Types
Memory Card File Specifications
Removing a Memory Card
Parent topic: Using Memory Cards With Your Product

Memory Card Types
You can insert these types of memory cards in your product.

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for details on using it.

Left Slot
You can insert the following cards in the left slot:

- Memory Stick Duo
- Memory Stick PRO Duo
- Memory Stick PRO-HG Duo
- Memory Stick Micro*
- MagicGate Memory Stick Duo
- SDXC
- SDHC
- SD
- miniSDHC*
- miniSD*
- microSDXC*
- microSDHC*
- microSD*
Right Slot
You can insert the following cards in the right slot:
- CompactFlash
- Microdrive

Parent topic: Inserting a Memory Card

Memory Card File Specifications
You can insert memory cards in your product containing files that meet these specifications.

<table>
<thead>
<tr>
<th>File format</th>
<th>JPEG with the Exif version 2.3 standard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image size</td>
<td>80 × 80 pixels to 10200 × 10200 pixels</td>
</tr>
<tr>
<td>Number of files</td>
<td>Up to 9990</td>
</tr>
</tbody>
</table>

Parent topic: Inserting a Memory Card

Removing a Memory Card
After you finish working with a memory card, you can check to make sure it is safe to remove it from your product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is flashing or you may lose data from the memory card.
1. Make sure the memory card access light is not flashing.

2. If your product is connected to your computer using a USB cable, do one of the following:
   - **Windows**: Open the My Computer, Computer, or Windows Explorer utility. Then right-click the name of your memory card (listed as a removable disk) and select **Eject**.
   - **Mac OS X**: Drag the removable disk icon for your memory card from the desktop into the trash.

3. Pull the memory card straight out of its slot.

Parent topic: Inserting a Memory Card

---

## Printing from a Memory Card

See these sections to print photos from a memory card inserted into your product:

- Viewing and Printing Photos
- Printing Photo Layouts from a Memory Card
- Printing Photo Greeting Cards

Parent topic: Using Memory Cards With Your Product

---

## Viewing and Printing Photos

See these sections to view and print photos displayed on your product's LCD screen.

- Viewing and Printing Photos
- Cropping Photos Displayed on the LCD Screen
Viewing and Printing Photos

You can select photos for printing as you view them on the LCD screen.

1. Select **Print Photos**.

2. Do one of the following to select your photos:
   - To select individual photos, select the thumbnail image of the photo you want to print, then press + or – to select the number of copies (up to 99). Press the left or right arrow button to scroll through and select additional photos, or press the 5 back button to return to the thumbnail image view and select another photo.
   - To select all photos, select **Options > Select Photos > Select All Photos**, then press + or – to select the number of copies (up to 99). Select **Done** when finished.
   - To select photos based on the date they were taken, select **Browse > Browse by Date**, then select any of the dates shown. Select **Proceed**, then select the photos you want to print.

3. To adjust your photos, do either of the following as necessary (adjustments modify only your printed copy, not the original file):
   - To crop, zoom into, or rotate a photo, select the thumbnail image of the photo you want to modify, then select **Edit > Crop/Zoom**. Make the necessary adjustments, select **OK**, then **OK** again.
• To change the appearance (e.g., brightness and contrast) of your printed photos, select the thumbnail image of a photo, select **Edit > Photo Adjustments**, and select the necessary settings. When you are finished, press the back button twice.

4. To change the print settings, select **Settings**, then select the necessary settings. When you are finished, press the back button.

5. When you are ready to print, press the start button.

**Note:** To cancel printing, select **Cancel**.

**Parent topic:** Viewing and Printing Photos

**Related references**

- Photo Adjustment Options - Memory Card
- Print Setting Options - Memory Card

**Related tasks**

- Cropping Photos Displayed on the LCD Screen

**Cropping Photos Displayed on the LCD Screen**

If you want to crop or rotate photos displayed on the LCD screen, select the thumbnail image of the photo you want to modify, select **Edit > Crop/Zoom**, and select the necessary options.

- To crop the photo, press + to move the yellow crop area inward or – to move the crop area outward.
- To move the crop area, press the arrow buttons.
- To rotate the crop area, press .
- To check the cropped image, press **OK**.

**Parent topic:** Viewing and Printing Photos

**Photo Adjustment Options - Memory Card**

Select the **Photo Adjustment** options you want to use when viewing and printing photos displayed on the LCD screen. The modifications affect only the printed copy of the photo, not the original file.
<table>
<thead>
<tr>
<th>Photo Adjustment settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Photo</td>
<td>Fix Photo On</td>
<td>Automatically adjusts the brightness, contrast, and saturation of the photo based on the Scene Detection setting that is selected.</td>
</tr>
<tr>
<td></td>
<td>Fix Photo Off</td>
<td>Turns off automatic adjustments; see Note below</td>
</tr>
<tr>
<td></td>
<td>P.I.M.</td>
<td>Uses your camera’s PRINT Image Matching or Exif Print adjustments</td>
</tr>
<tr>
<td>Scene Detection</td>
<td>Automatic</td>
<td>Optimizes the Fix Photo adjustments for specific types of photos; select the option that best matches your photo content</td>
</tr>
<tr>
<td></td>
<td>People</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Night Scene</td>
<td></td>
</tr>
<tr>
<td>Fix Red-Eye</td>
<td>Off - Current</td>
<td>Automatically fixes the red-eye effect in photos</td>
</tr>
<tr>
<td></td>
<td>On - Current</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Off - All Photos</td>
<td></td>
</tr>
<tr>
<td></td>
<td>On - All Photos</td>
<td></td>
</tr>
<tr>
<td>Brightness</td>
<td>Various settings</td>
<td>Adjust individual qualities in your photo</td>
</tr>
<tr>
<td>Contrast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sharpness</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject’s face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the special color effects.

**Parent topic:** Viewing and Printing Photos

**Print Setting Options - Memory Card**

Select the Print Settings options you want to use when printing photos displayed on the LCD screen.
<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Various paper sizes</td>
<td>Indicates the size of paper you have loaded</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Various paper types</td>
<td>Indicates the type of paper you have loaded; see the list of paper types for memory card (available options depend on the selected Paper Size setting)</td>
</tr>
<tr>
<td>Paper Source</td>
<td>Cassette 1</td>
<td>Prints onto paper loaded in Cassette 1 (upper cassette)</td>
</tr>
<tr>
<td></td>
<td>Cassette 2</td>
<td>Prints onto paper loaded in Cassette 2 (lower cassette)</td>
</tr>
<tr>
<td></td>
<td>Cassette 1&gt;Cassette 2</td>
<td>Prints onto paper loaded in Cassette 1 and then onto paper loaded in Cassette 2 when the first cassette is empty (load the same size and type of paper in both cassettes when selecting this option)</td>
</tr>
<tr>
<td></td>
<td>Rear Paper Feed Slot</td>
<td>Prints onto paper loaded in the rear paper feed slot</td>
</tr>
<tr>
<td>Borderless</td>
<td>Borderless</td>
<td>Expands the image to the edge of the paper (slight cropping may occur)</td>
</tr>
<tr>
<td></td>
<td>With Border</td>
<td>Leaves a small margin around the image</td>
</tr>
<tr>
<td>Quality</td>
<td>Draft</td>
<td>Provides lower quality for draft printing</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>Provides good quality for most prints</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>Provides the highest quality for important prints</td>
</tr>
<tr>
<td>Expansion</td>
<td>Standard</td>
<td>Expands images correctly for most borderless prints</td>
</tr>
<tr>
<td></td>
<td>Medium</td>
<td>Expands images slightly less for borderless prints</td>
</tr>
<tr>
<td></td>
<td>Minimum</td>
<td>Expands images the least for borderless prints (you may see some white border)</td>
</tr>
<tr>
<td>Date</td>
<td>Various date formats</td>
<td>Prints the date the photo was taken on the photo in the format you select</td>
</tr>
<tr>
<td>Print settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Info. On Photos</td>
<td>Camera Settings</td>
<td>Prints settings that you added in your camera</td>
</tr>
<tr>
<td></td>
<td>Camera Text</td>
<td>Prints text that you added in your camera</td>
</tr>
<tr>
<td></td>
<td>Landmark</td>
<td>Prints location information embedded in a photo by cameras with GPS feature</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off printing info from your camera</td>
</tr>
<tr>
<td>Fit Frame</td>
<td>On</td>
<td>Automatically crops the photo to fit into the selected photo layout</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic cropping</td>
</tr>
<tr>
<td>Bidirectional</td>
<td>On</td>
<td>Prints at normal speed</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Slows down printing to improve print quality</td>
</tr>
<tr>
<td>Clear All Settings</td>
<td>Yes</td>
<td>Clears all print settings</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Parent topic: Viewing and Printing Photos

Related references
Paper Type Settings - Memory Card

Paper Type Settings - Memory Card

Select a **Paper Type** setting that matches the paper you loaded.

<table>
<thead>
<tr>
<th>Paper type loaded</th>
<th>Paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer paper</td>
<td></td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Paper type loaded</td>
<td>Paper Type setting</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Matte</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Prem. Glossy</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td></td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Ultra Glossy</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Glossy</td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Velvet Fine Art Paper</td>
</tr>
</tbody>
</table>

Parent topic: Viewing and Printing Photos

**Printing Photo Layouts from a Memory Card**

You can print one or more photos from a memory card in special layouts on various sizes of photo paper.

1. Press the ⏏ home button, if necessary.
2. Select More Functions.
3. Select **Photo Layout Sheet**.

4. Scroll down to view all of the layout options, then select the option you want.

5. Select the paper size and paper type that matches the paper you loaded, then select **Proceed**.

6. If you see a screen asking you to choose between automatic and manual placement of photos, do one of the following:
   - Select **Automatic layout** if you want to allow your product to place the photos in the layout automatically.
   - Select **Place photos manually** to place photos in the layout manually.

7. Select the photos you want to print, then select **Proceed**. If you chose to place the photos manually, follow the instructions on the LCD screen to select and place your photos on the layout, then select **Proceed**.

8. Press + or – to select the number of layout sheets to print (up to 99), then select **Proceed**.

9. Select additional print settings for your layout as necessary.

10. When you are ready to print, press the  start button.

    **Note:** To cancel printing, select **Cancel**.

**Photo Layout Options**

**Parent topic:** Printing from a Memory Card
Photo Layout Options

Select the layout you want to use when printing your photos in a layout.

Picture Package
Prints one photo in multiple sizes on one sheet.

2-up, 4-up, 8-up, or 20-up
Print 2, 4, 8, or 20 photos on one sheet.

Upper ½ or Lower ½
Print one photo in the upper or lower half of the sheet.

Photo ID
Prints 4 ID-sized photos on one sheet.

Jewel Upper
Prints one photo on the upper half of a folded jewel case insert.

Jewel Index
Prints 24 to 48 thumbnail images on a folded jewel case insert.

Parent topic: Printing Photo Layouts from a Memory Card

Printing Photo Greeting Cards

You can create custom greeting cards using photos on your memory card or other device, and add your own handwritten or printed text.

First you select your photo and print a template on plain paper. Then you fill out the template, add your message, and print your cards.

Creating and Printing a Greeting Card Template
Printing a Greeting Card from a Template

Parent topic: Printing from a Memory Card

Creating and Printing a Greeting Card Template

Before you start, make sure plain paper is loaded and your memory card is inserted.

1. Press the home button, if necessary.
2. Select **More Functions**.

3. Select **Greeting Card**.

4. Select **Select Photo and Print Template**.

5. Select the photo you want, then select **Proceed**.

6. Select **Paper Size**, then select **Letter** to print three cards on one letter-size sheet or **4x6in** to print one card.

7. Select **Paper Type**, then select the type of paper you plan to use.

8. Select the other print settings as necessary, then select **Proceed**.
9. When you are ready to print your greeting card template on plain paper, press the start button.

Parent topic: Printing Photo Greeting Cards

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing a Greeting Card from a Template

After your greeting card template is printed, you fill it out to create your card and add your message.

1. Use a dark pen or pencil to fill in the circles and select the Text Style and Text Effects.

2. Add your greeting card message within the box. You can write it in by hand, print a message and paste it into the box, or draw a picture.

   Tip: When adding text, place it in the direction that your photo faces.

3. Load photo paper either in Cassette 2 (lower) for this size: Letter (8.5 × 11 inches [216 × 279 mm]), or in Cassette 1 (upper) for this size: 4 × 6 inches (102 × 152 mm).

4. Select Print Greeting Cards from Template. (If you don't see the option, press the home button and select More Functions > Greeting Card > Print Greeting Cards from Template.)

5. Follow the instructions on the LCD screen to place the template facedown on the scanner glass, with the blue triangle facing into the front right corner.
6. Close the document cover, then select Proceed.
7. To print more than one copy, press + or – to select the number (up to 99).
8. When you are ready to print, press the start button.

   Note: To cancel printing, select Cancel.

When you finish printing, cut your greeting cards apart, if necessary.

Parent topic: Printing Photo Greeting Cards
Related tasks
Creating and Printing a Greeting Card Template

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.

Setting Up File Sharing for Photo Transfers From Your Computer
Transferring Photos from a Memory Card to Your Computer

Parent topic: Using Memory Cards With Your Product

Setting Up File Sharing for Photo Transfers From Your Computer
Before you transfer photos from a computer to a memory card inserted into a memory card slot on your product, you may need to set up your product's file sharing settings.

1. Remove any memory cards from the product.

   Caution: Remove the memory card before you change the file sharing settings or you may lose data from the memory card. Do not remove a memory card or turn off your product while the memory card access light is flashing or you may lose data from the memory card.

2. Press the home button, if necessary.
3. Select Setup.
5. Select the connection type between the printer and your computer.

Parent topic: Transferring Photos on a Memory Card
Transferring Photos from a Memory Card to Your Computer

You can transfer photos to and from a memory card inserted into a memory card slot on your product and a computer connected to your product.

**Note:** Do not transfer photos to and from a memory card while you are printing from the memory card.

1. Make sure your product is connected to a computer.
2. Insert a memory card into a memory card slot on your product.
3. Do one of the following to access your memory card files from your computer:
   - **Windows:** Select the Computer or My Computer utility, then select the removable disk icon.
   - **Mac OS X with a USB connection:** Look for the removable disk icon on your desktop, then select it.
   - **Mac OS X with a network connection:** Select the hard drive icon on your desktop or select Computer from the Go menu, select your product in the SHARED section of the sidebar (you may need to widen the sidebar to see the name), then select the MEMORYCARD icon.
4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

**Note:** Your product's LCD screen does not update to display new photos transferred to the memory card. Wait until the memory card access light stops flashing, then remove and insert the memory card to update the photos displayed.

Related tasks
- Removing a Memory Card
- Inserting a Memory Card
- Removing a Memory Card

Parent topic: Transferring Photos on a Memory Card
Using an External Device with Your Product

Follow the instructions in these sections to use your product with an external device, such as a camera, smartphone, or other device.

- Printing from a Camera
- Viewing or Printing from a USB Flash Drive or External Device

Printing from a Camera

If you have a digital camera that supports PictBridge printing, you can print your photos directly from the camera. Check your camera manual to see if it is compatible.

**Note:** Your photos must be in JPG format and sized from 80 × 80 to 10200 × 10200 pixels. Epson cannot guarantee the compatibility of your camera. Some combinations of paper type, size, and layout may not be supported, depending on your camera and the product settings.

- Selecting Print and Photo Adjustment Settings
- Connecting and Printing from a Camera
- Printing from a Camera Wirelessly

Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings

Before printing from your camera, you can make image adjustments and select the print settings for your photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Press the 🏛 home button, if necessary.
2. Press the left or right arrow button and then select **Setup**.

3. Scroll down and select **External Device Setup**.
4. Select **Print Settings**.

5. Select the print settings you want to use.

6. When you are done, press the back button.

7. Select **Photo Adjustments**.

8. Select the photo adjustments you want to use, then press the home button to exit.

After you select settings, you are ready to connect your camera and print your photos.

*Print Settings - Camera*
Select the **Print Settings** options you want to use when printing photos from your camera.

<table>
<thead>
<tr>
<th>Print settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Size</td>
<td>Various paper sizes</td>
<td>Indicates the size of paper you have loaded</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Various paper types</td>
<td>Indicates the type of paper you have loaded; see the list of paper types for copying (available options depend on the selected <strong>Paper Size</strong> setting)</td>
</tr>
<tr>
<td>Paper Source</td>
<td>Cassette 1</td>
<td>Prints onto paper loaded in Cassette 1 (upper cassette)</td>
</tr>
<tr>
<td></td>
<td>Cassette 2</td>
<td>Prints onto paper loaded in Cassette 2 (lower cassette)</td>
</tr>
<tr>
<td></td>
<td>Cassette 1&gt; Cassette 2</td>
<td>Prints onto paper loaded in Cassette 1 and then onto paper loaded in Cassette 2 when the first cassette is empty (load the same size and type of paper in both cassettes when selecting this option)</td>
</tr>
<tr>
<td>Rear Paper Feed Slot</td>
<td></td>
<td>Prints onto paper loaded in the rear paper feed slot</td>
</tr>
<tr>
<td>Print settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td><strong>Borderless</strong></td>
<td>Expands the image to the edge of the paper (slight cropping may occur)</td>
</tr>
<tr>
<td></td>
<td><strong>With Border</strong></td>
<td>Leaves a small margin around the image</td>
</tr>
<tr>
<td></td>
<td><strong>Picture Package</strong></td>
<td>Prints one photo in multiple sizes on one sheet</td>
</tr>
<tr>
<td></td>
<td><strong>2-up, 4-up, 8-up, 20-up, 30-up, or 80-up</strong></td>
<td>Prints the selected number of photos on one sheet or CD/DVD</td>
</tr>
<tr>
<td></td>
<td><strong>Photo ID</strong></td>
<td>Prints 4 ID-sized photos on one sheet</td>
</tr>
<tr>
<td></td>
<td><strong>Upper ½ or Lower ½</strong></td>
<td>Print one photo in the upper or lower half of the sheet</td>
</tr>
<tr>
<td></td>
<td><strong>Jewel Upper</strong></td>
<td>Prints one photo on the upper half of a folded jewel case insert</td>
</tr>
<tr>
<td></td>
<td><strong>Jewel Index</strong></td>
<td>Prints 24 to 48 thumbnail images on a folded jewel case insert</td>
</tr>
<tr>
<td><strong>Quality</strong></td>
<td><strong>Draft</strong></td>
<td>Provides lower quality for draft printing</td>
</tr>
<tr>
<td></td>
<td><strong>Standard</strong></td>
<td>Provides good quality for most prints</td>
</tr>
<tr>
<td></td>
<td><strong>Best</strong></td>
<td>Provides the highest quality for important prints</td>
</tr>
<tr>
<td><strong>Expansion</strong></td>
<td><strong>Standard</strong></td>
<td>Expands images correctly for most borderless prints</td>
</tr>
<tr>
<td></td>
<td><strong>Medium</strong></td>
<td>Expands images slightly less for borderless prints</td>
</tr>
<tr>
<td></td>
<td><strong>Minimum</strong></td>
<td>Expands images the least for borderless prints (you may see some white border)</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td><strong>Off</strong></td>
<td>Does not print the date on which the photo was taken</td>
</tr>
<tr>
<td></td>
<td><strong>On</strong></td>
<td>Prints the date on which the photo was taken</td>
</tr>
<tr>
<td>Print settings</td>
<td>Available options</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Print Info. On Photos</td>
<td>Off</td>
<td>Turns off printing info from your camera</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Prints your camera's shutter speed, aperture, and ISO speed</td>
</tr>
<tr>
<td>Camera Text</td>
<td>Off</td>
<td>Prints text that you added in your camera</td>
</tr>
<tr>
<td>Landmark</td>
<td>Off</td>
<td>Prints location information embedded in a photo by cameras that have a built-in GPS feature</td>
</tr>
<tr>
<td>Fit Frame</td>
<td>On</td>
<td>Automatically crops the photo to fit into the selected photo layout</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Turns off automatic cropping</td>
</tr>
<tr>
<td>Bidirectional</td>
<td>On</td>
<td>Prints at normal speed</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Slows down printing to improve print quality</td>
</tr>
<tr>
<td>CD Inner/Outer</td>
<td>Range of measurements</td>
<td>Selects inner and outer diameter for printing on CDs/DVDs from your camera</td>
</tr>
<tr>
<td>CD Density</td>
<td>Standard</td>
<td>Adjusts the print density when printing on CDs/DVDs from your camera</td>
</tr>
<tr>
<td></td>
<td>Darker</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Darkest</td>
<td></td>
</tr>
<tr>
<td>Clear All Settings</td>
<td>Yes</td>
<td>Clears all print settings</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Parent topic:** Selecting Print and Photo Adjustment Settings

**Related references**

*Paper Type Settings - Copying*

**Photo Adjustments - Camera**

Select the **Photo Adjustments** options you want to use when printing photos from your camera. The modifications affect only the printed copy of the photo, not the original file.
<table>
<thead>
<tr>
<th>Photo Adjustments settings</th>
<th>Available options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fix Photo</td>
<td>Fix Photo On</td>
<td>Automatically adjusts the brightness, contrast, and saturation of the photo based on the <strong>Scene Detection</strong> setting that is selected</td>
</tr>
<tr>
<td></td>
<td>Fix Photo Off</td>
<td>Turns off automatic adjustments; see <strong>Note</strong> below</td>
</tr>
<tr>
<td></td>
<td>P.I.M</td>
<td>Uses your camera's PRINT Image Matching or Exif Print adjustments</td>
</tr>
<tr>
<td>Scene Detection</td>
<td>Automatic</td>
<td>Optimizes the <strong>Fix Photo</strong> adjustments for specific types of photos; select the option that best matches your photo content</td>
</tr>
<tr>
<td></td>
<td>People</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Landscape</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Night Scene</td>
<td></td>
</tr>
<tr>
<td>Fix Red-Eye</td>
<td>Off</td>
<td>Does not automatically fix the red-eye effect in photos</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>Automatically fixes the red-eye effect in photos</td>
</tr>
<tr>
<td>Filter</td>
<td>Off</td>
<td>Turns off the filter setting</td>
</tr>
<tr>
<td></td>
<td>Sepia</td>
<td>Applies a sepia tone filter to the viewed or printed photo</td>
</tr>
<tr>
<td></td>
<td>B&amp;W</td>
<td>Applies a black-and-white filter to the viewed or printed photo</td>
</tr>
<tr>
<td>Brightness</td>
<td>Various settings</td>
<td>Adjust individual qualities in your photo</td>
</tr>
<tr>
<td>Contrast</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sharpness</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Saturation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear All Settings</td>
<td>Yes</td>
<td>Clear all photo adjustment settings</td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** **Fix Photo** uses a sophisticated face recognition technology to optimize photos that include faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a face with an intentional color cast, such as a statue, you may want to turn off **Fix Photo** to retain the special color effects.
Parent topic: Selecting Print and Photo Adjustment Settings

Connecting and Printing from a Camera

Before you connect your camera, make sure the product is turned on but not printing.

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Connect the USB cable that came with your camera to the USB port on the front of your product.

   **Note:** You cannot use the USB port to transfer images from your camera to your computer.

4. Turn on your camera.
5. Follow the instructions that came with your camera to select and print your photos.

When you finish printing, turn off your camera and disconnect it from the product.

Parent topic: Printing from a Camera

Related tasks
- Removing a Memory Card

Related topics
- Loading Paper

Printing from a Camera Wirelessly

You can print photos from a digital camera using a wireless connection. Make sure your digital camera can connect to a network and is PictBridge compatible (DPS over IP).
1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Turn on your camera.
4. Setup the camera’s wireless network connection. See the documentation that came with your camera for details.

   **Note:** Make sure the camera is connected to the same network as the product. You can print a Network Status sheet to view your product's network settings.

5. Follow the instructions that came with your camera to select and print your photos.

When you finish printing, turn off your camera and disconnect it from the network.

**Parent topic:** Printing from a Camera

### Viewing or Printing from a USB Flash Drive or External Device

You can view and print photos from a USB thumb drive or other external storage device, such as an external hard drive or CD/DVD burner.

**Note:** Make sure the files on your device are compatible with the product.

**USB Device File Specifications**

**Connecting and Using a USB Flash Drive or External Device**

**Parent topic:** Using an External Device with Your Product

**Related tasks**

- Viewing and Printing Photos
- Removing a Memory Card

**Related topics**

- Loading Paper

**USB Device File Specifications**

You can print external device files that meet these specifications.

- **File format**: JPEG with the Exif version 2.3 standard
- **Image size**: 80 × 80 pixels to 10200 × 10200 pixels
Number of files | Up to 9990

Parent topic: Viewing or Printing from a USB Flash Drive or External Device

Connecting and Using a USB Flash Drive or External Device

Before you connect your thumb drive or device, make sure the product is turned on but not printing.

**Note:** Epson cannot guarantee the compatibility of your drive.

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Insert your USB thumb drive or the USB cable that came with your device into the USB port on the front of your product.
4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.

When you finish printing, make sure the access light on the drive is not flashing, then remove or disconnect it from the product.

**Caution:** Do not remove the USB drive or turn off the product when the access light is flashing, or you may lose photos on the drive.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
Printing Personalized Projects

You can turn any photo or drawing into a coloring book page, or print lined paper, graph paper, or stationery with a photo background.

Printing Coloring Book Pages
Printing Personalized Note Paper
Printing Lined Paper, Graph Paper, and Music Sheets
Printing Calendar Pages

Printing Coloring Book Pages

You can create a coloring book page from a photo on your memory card, or from a photo or drawing placed on the scanner glass.

1. Load one of these types of paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size:
   • Plain paper
   • Epson Bright White Paper
   • Epson Presentation Paper Matte
   • Epson Premium Presentation Paper Matte
   • Epson Velvet Fine Art Paper (letter-size only)

2. Press the home button, if necessary.
3. Select **More Functions**.

4. Scroll down and select **Coloring Book**.

5. Do one of the following:
   - Select **Photo or Drawing on Scanner Glass** to print a design from an original placed facedown on the scanner glass, in the front right corner.
   - Select **Photo on Memory Card** to print a design from a memory card inserted in your product, then select a photo.

6. Select **Proceed**.
7. Select Paper Settings and select the size and type of paper that you loaded.
8. Select Paper Source and select where you loaded your paper.
9. If necessary, adjust the following settings:
   - Density to make the print lighter or darker
   - Line Detection to change the amount of detail in the print
10. When you are ready to print, press the start button.

   **Note:** To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related tasks
Inserting a Memory Card
Placing Originals on the Scanner Glass

Related topics
Loading Paper

### Printing Personalized Note Paper

You can print lined or unlined note paper with one of your own photos in the background.

1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size.
2. Insert a memory card into your product's memory card slot.
3. Press the home button, if necessary.
4. Select **More Functions**.

5. Scroll down and select **Personal Stationery**.
6. Select **Writing Papers**.

7. Scroll down and select one of the following settings:
   - **Horizontal Rule**
   - **Vertical Rule**
• Without Rule

Note: View the thumbnails next to each option to preview the design layout.

8. Select the size of paper you loaded.
9. Select the photo you want to use for your note paper, then select Proceed.

Note: To rotate the layout, select Rotate.

10. When you see a message asking you to load paper, select Proceed.
11. To print more than one sheet, press + or – to select the number (up to 99).
12. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing Lined Paper, Graph Paper, and Music Sheets
You can print wide-rule or narrow-rule notebook paper and graph paper.

1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size.
2. Press the home button, if necessary.
3. Select More Functions.

4. Scroll down and select Personal Stationery.

5. Select Lined Papers.

6. Select one of the following settings:
   - Wide Rule
   - Thin Rule
   - Graph Rule
• Music Paper

Note: View the thumbnails next to each option to preview the design layout.

7. Select the size of paper you loaded.
8. When you see a message asking you to load paper, select Proceed.
9. To print more than one sheet, press + or – to select the number (up to 99).
10. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
Related topics
Loading Paper

Printing Calendar Pages

You can create and print a weekly or monthly calendar page from your product.

1. Load plain paper in either Letter (8.5 × 11 inches [216 × 279 mm]) or A4 (8.3 × 11.7 inches [210 × 297 mm]) size.
2. Press the home button, if necessary.
3. Select More Functions.
4. Scroll down and select **Personal Stationery**.

![Personal Stationery menu]

5. Select **Calendar**.
6. Select one of the following settings:
   - **Weekly**: prints a Sunday to Saturday week-long calendar with hourly divisions.
   - **Monthly**: prints a monthly calendar for a chosen month and year.

   **Note**: View the thumbnails next to each option to preview the design layout.

7. If you choose **Monthly**, enter the year and month and press **Done**.
8. Select the type of paper to print on.
9. When you see a message asking you to load paper, select **Proceed**.
10. To print more than one sheet, press + or – to select the number (up to 99).
11. When you are ready to print, press the start button.

   **Note**: To cancel printing, select **Cancel**.

**Parent topic**: Printing Personalized Projects  
**Related topics**

- Loading Paper
Printing on CDs/DVDs

Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.

CD/DVD Printing Features

Loading a CD/DVD
Removing a Printed CD/DVD
Placing a CD/DVD on the Scanner Glass
Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card
Printing on CDs/DVDs from a Computer

CD/DVD Printing Features

You can use any of the following features to print custom CD/DVD labels and accessories:

• Copy an existing CD/DVD label onto a new CD/DVD
• Use your product's control panel to print photos from a memory card onto a CD/DVD
• Print text and images from your computer using the Epson Print CD software

You can also use your product's control panel to create a jewel case insert with photos from a memory card.

Parent topic: Printing on CDs/DVDs

Related tasks

Copying onto a CD/DVD
Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card

Loading a CD/DVD

You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do not insert the CD/DVD tray while the product is printing, copying, or performing other operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty or scratched.
**Note:** If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center hole, you may need to adjust the inner diameter setting using the control panel or Epson Print CD software.

1. Burn your files, music, or video onto your disc before printing on it.
2. Press the home button, if necessary.
3. Press the CD button and select **Load CD/DVD**.
4. When you see a message asking if you want to prepare for CD loading, select **Yes**.
5. Raise the control panel all the way up.

![Control panel up](image1)

6. Make sure nothing is on the output tray, then close it.

![Output tray closed](image2)

7. Close the front cover.
8. Remove the CD/DVD tray from the bottom of the product.

9. Place a CD or DVD on the CD/DVD tray with the printable side faceup, and insert the tray into the slot above the output tray.

   ![Diagram of CD/DVD tray insertion]

   **Note:** Make sure the ▲ marks on the tray and the ▼ marks on the product line up.

10. Select **Ready > OK** on the touch panel.

   **Note:** The CD/DVD tray ejects automatically after a certain period of time.

   **Caution:** Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.
Removing a Printed CD/DVD

After your CD or DVD is printed, the tray extends automatically.

1. Pull the CD/DVD tray out of the product, and then remove your CD or DVD from the tray.

2. Insert the CD/DVD tray into the storage slot on the bottom of the product.

After printing, handle the CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from moisture and direct sunlight.

Parent topic: Printing on CDs/DVDs
Placing a CD/DVD on the Scanner Glass

You can place a CD or DVD on the scanner glass and copy the label design onto another CD or DVD.
1. Open the document cover.
2. Place your CD or DVD facedown in the center of the scanner glass.
3. Close the document cover gently to keep your disc in place.

Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD

You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want, you can first print a test design on plain paper.
1. Load the CD, DVD, or plain paper you want to print on.
2. Press the home button, if necessary.
3. Press the CD button.
4. Select CD/DVD Copy.
5. Follow the instructions on the LCD screen to place your original CD, DVD, or photo on the scanner glass, then select Proceed.
6. If necessary, adjust the inner and outer diameter of your CD as shown on the screen, then select Proceed.

You see this screen:
7. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If printing on plain paper, select Proceed.

8. Select any copy settings as needed.

9. When you are ready to print, press the start button.

   **Note:** To cancel printing, select Cancel.

**Parent topic:** Printing on CDs/DVDs
Printing Photos from a Memory Card Onto a CD/DVD

You can print one or more photos from a memory card directly onto a CD/DVD. If you want, you can first print a test design on plain paper.

1. Insert a memory card into a memory card slot on your product.
2. Load the CD, DVD, or plain paper you want to print on.
3. Press the home button, if necessary.
4. Press the CD button.
5. Select Print on CD/DVD.
6. Select a layout.
7. Follow the instructions on the screen to select your photo or photos.
8. When you see the screen to adjust the inner and outer diameter of your CD, adjust the settings if necessary, then select Proceed.
You see this screen:

9. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If printing on plain paper, select **Proceed**.
10. Adjust the **CD Density** setting if necessary, then press the start button to print.

**Note:** To cancel printing, select **Cancel**.

**Parent topic:** Printing on CDs/DVDs

**Related tasks**
- Loading a CD/DVD
- Inserting a Memory Card

**Related topics**
- Loading Paper

### Printing a Jewel Case Insert from a Memory Card

You can print a photo from a memory card, automatically sized to fit on a CD/DVD jewel case insert. You can also print thumbnail images formatted to fit on a jewel case insert. After the insert is printed, you can cut and fold it to fit.

1. Insert a memory card into a memory card slot on your product.
2. Load the paper you want to print on.
3. Press the 🏡 home button, if necessary.
4. Select **More Functions**.

5. Select **Photo Layout Sheet**.

6. Scroll down and then select one of the following:
   - **Jewel Upper** to print one photo on the upper half of the insert.
   - **Jewel Index** to print 24 or 48 thumbnail images on the insert.

7. Select your paper size and type, then select **Proceed**.
8. Follow the instructions on the LCD display to select your photos and set the number of copies.
9. When you see the Print Settings screen, change your print settings if necessary.
10. When you are ready to print, press the start button.

Note: To cancel printing, select Cancel.

11. After your insert is printed, cut and fold it following the crop lines.

Parent topic: Printing on CDs/DVDs
Related tasks
Inserting a Memory Card
Related topics
Loading Paper

Printing on CDs/DVDs from a Computer

Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as described on the Start Here sheet, and installed the Epson Print CD software.

Printing on a CD/DVD with Windows
Printing on a CD/DVD with Mac OS X

Parent topic: Printing on CDs/DVDs
Related tasks
Loading a CD/DVD

Printing on a CD/DVD with Windows

You can print with your product using the Epson Print CD software, as described in these sections.

Designing a CD/DVD - Windows
Printing Your CD/DVD Design - Windows
Adjusting CD/DVD Print Position - Windows
Adjusting CD/DVD Print Quality - Windows

Parent topic: Printing on CDs/DVDs from a Computer

Designing a CD/DVD - Windows

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special effects.
1. Open the Epson Print CD program on your computer.
   You see this screen:

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.

Parent topic: Printing on a CD/DVD with Windows

Printing Your CD/DVD Design - Windows

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and click Print.
   You see this screen:
2. Make sure your product is selected as the **Printer** setting.
3. To see how your design will look without printing on the disc, click **Test Print** and follow the instructions on the screen.
4. When you are ready to print on the disc, click the **Print** button on the screen.
5. Click **Print**.

**Parent topic:** Printing on a CD/DVD with Windows

**Adjusting CD/DVD Print Position - Windows**

If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and click **Print**.
   
   You see this screen:
2. Select **Print Position Confirmation Pattern**.
3. Click **Print**.
4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled **Top** and **Right**.
   
   **Note:** Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Click **Print** again, then select **Adjust Print Position**.
   
   You see this screen:
7. Click **Enter Values**, then select the distance for Top into the **Height (Top)** box and the distance for Right in the **Width (Right)** box.

8. Click **OK**.

**Parent topic:** Printing on a CD/DVD with Windows

**Adjusting CD/DVD Print Quality - Windows**

If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density. This may be necessary to make sure your designs look their best on the particular brand of discs you are using. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and click **Print**.

You see this screen:
2. Select **Print Density Confirmation Pattern**.
3. Click **Print**.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Click **Print**.
7. Adjust the **Print Color Correction** slider to a darker or lighter setting as necessary.
8. Select **Print Density Confirmation Pattern** and select the **Second** radio button.
9. Click **Print** to print another test pattern.
10. Examine the disc after printing to see if further adjustment is needed.

When the ink density looks good, you are ready to print on your burned CD or DVD.

**Parent topic:** Printing on a CD/DVD with Windows

### Printing on a CD/DVD with Mac OS X

You can print with your product using the Epson Print CD software, as described in these sections.

**Designing a CD/DVD - Mac OS X**
Designing a CD/DVD - Mac OS X

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special effects.

1. Open the Epson Print CD program in the Applications > Epson Software > Print CD folder on your Mac.

You see this screen:

2. Use the icons on the left side of the screen to add a background image, picture, text, or graphic elements.

3. When you are finished creating your design, make sure you save it.
Printing Your CD/DVD Design - Mac OS X

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Open your file in Epson Print CD and select **Print** from the File menu.

You see this screen:

```
Print

Select Printer Manual Print
Printer: EPSON
Copies: 1

Test Print

Media Type: CD/DVD

Color Correction

Light Standard Strong
-3 -2 -1 0 +1 +2 +3

Adjust Print Position

Horizontal 0.0 mm
Vertical 0.0 mm

Position Adjustment

Print Check Pattern

None
Print Density Check Pattern

Tray

Print

Cancel
```

2. Make sure your product is selected as the **Printer** setting.
3. To see how your design will look without printing on the disc, select **Test Print** and follow the instructions on the screen.
4. When you are ready to print on the disc, click the **Print** button on the screen.

Adjusting CD/DVD Print Position - Mac OS X

If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and select **Print** from the File menu.
You see this screen:

```
2. Select **Print Position Check Pattern**.
3. Click **Print**.
4. Remove the disc after printing.
5. Using a metric ruler, measure the distance from the hole to the cross marks labeled **Top** and **Right**.
   
   **Note:** Be sure to measure from the edge of the hole and not the edge of the printable area.

6. Select **Print** from the File menu.
7. Select **Position Adjustment**.
You see this screen:
```
8. Click Value Entry, then select the distance for Top into the Top Space box and the distance for Right in the Right Space box.

9. Click OK.

Parent topic: Printing on a CD/DVD with Mac OS X

Adjusting CD/DVD Print Quality - Mac OS X

If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density. This may be necessary to make sure your designs look their best on the particular brand of discs you are using. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and select Print from the File menu.

You see this screen:
2. Select **Print Density Check Pattern**.
3. Click **Print**.
4. Remove the disc after printing and check to see if you need to make the density darker or lighter.
5. Load the same disc in the product again.
6. Select **Print** from the File menu.
7. Select a darker or lighter setting in the **Color Correction** box as necessary.
8. Select **Print Density Check Pattern** and select **Second Time**.
9. Click **Print** to print another test pattern.
10. Examine the disc after printing to see if further adjustment is needed.

When the ink density looks good, you are ready to print on your burned CD or DVD.

**Parent topic:** Printing on a CD/DVD with Mac OS X
Replacing Ink Cartridges

When an ink cartridge is expended, you need to replace it. You may also need to replace a cartridge that is more than six months old, if your printouts do not look their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges responsibly and in accordance with local requirements. If you would like to return your used ink cartridges to Epson for proper disposal, please go to epson.com/recycle for more information.

Check Cartridge Status
Purchase Epson Ink Cartridges
Removing and Installing Ink Cartridges
Printing With Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Check Cartridge Status

Your product and its printing software will let you know when an ink cartridge is low or expended.

Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with Mac OS X

Parent topic: Replacing Ink Cartridges

Checking Cartridge Status on the LCD Screen

You can check the status of your ink cartridges using your product's LCD screen.

1. Press the home button, if necessary.
2. Select **Setup**.

3. Select **Ink Levels**.
   
   The ink cartridge status is displayed.

   **Note:** Displayed ink levels are approximate.

4. Select **OK** to exit.

---

**Parent topic:** Check Cartridge Status

**Related tasks**

- Removing and Installing Ink Cartridges

---

### Checking Cartridge Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at any time using a utility on your Windows computer.

1. To check your cartridge status, double-click the product icon in the Windows taskbar.
   
   You see this window:
2. Replace or reinstall any ink cartridge indicated on the screen.

   **Note:** If any of the cartridges installed in the product are broken, incompatible with the product model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. To disable the low ink reminder, right-click the product icon in the Windows taskbar and select **Monitoring Preferences**.
   You see this window:
4. Deselect the **See Low Ink Reminder alerts** checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the **Display Epson Offers** checkbox.

**Parent topic:** Check Cartridge Status  
**Related tasks**  
Removing and Installing Ink Cartridges
Checking Cartridge Status with Mac OS X

You can check your cartridge status using a utility on your Mac.

1. Do one of the following:
   • Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
   • Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, select your product, and select Open Print Queue. Select Utility.

2. Select EPSON Status Monitor.

   You see this window:
3. Do the following as necessary:
   - To update the ink cartridge status, click **Update**.

**Parent topic:** Check Cartridge Status

**Related tasks**
Removing and Installing Ink Cartridges

---

**Purchase Epson Ink Cartridges**

You can purchase genuine Epson ink and paper at Epson Supplies Central at [epson.com/ink3](http://epson.com/ink3) (U.S. sales) or [epson.ca](http://epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

**Note:** We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink is used for priming, the rest is available for printing. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Ink Cartridge Part Numbers**

**Parent topic:** Replacing Ink Cartridges

---

**Ink Cartridge Part Numbers**

Use these part numbers when you order or purchase new ink cartridges.

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
<th>Standard-capacity</th>
<th>High-capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>277</td>
<td></td>
<td>277XL</td>
</tr>
<tr>
<td>Cyan</td>
<td>277</td>
<td></td>
<td>277XL</td>
</tr>
<tr>
<td>Magenta</td>
<td>277</td>
<td></td>
<td>277XL</td>
</tr>
<tr>
<td>Yellow</td>
<td>277</td>
<td></td>
<td>277XL</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>277</td>
<td></td>
<td>277XL</td>
</tr>
</tbody>
</table>
### Ink Cartridges

<table>
<thead>
<tr>
<th>Ink color</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Standard-capacity</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>277</td>
</tr>
</tbody>
</table>

Parent topic: Purchase Epson Ink Cartridges

## Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new cartridges immediately after removing the old ones.

**Caution:** Leave your old cartridges in the printer until you are ready to replace them to prevent the print head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

1. Make sure that the CD/DVD tray is not inserted for printing.
2. Turn on your product.
   - If an ink cartridge is expended, you see a message on the LCD screen. Note which cartridges need to be replaced and select **Proceed**, then choose **Yes, replace now**.
   - If you are replacing a cartridge before you see a message on the LCD screen, select **Setup > Maintenance > Ink Cartridges Replacement**.
3. Lift up the scanner unit.

**Caution:** Do not move the print head by hand; otherwise, you may damage your product. Do not touch the flat white cable inside the printer.
4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink cartridge to remove it.

![Image showing the process of removing an ink cartridge]

**Warning:** If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away. Keep ink cartridges out of the reach of children.

5. Recap the used ink cartridge using the cap that came with it.

![Image showing how to recap an ink cartridge]

**Note:** Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.
6. Remove the new ink cartridge from the package.

![Diagram of opening cartridge](image)

**Caution:** Do not shake the cartridges after opening the packages, or ink may leak. Do not touch the areas shown above. Doing so may prevent normal operation and printing.

7. Remove the cap from the cartridge and store it for later use.

![Diagram of removing cap](image)

**Note:** Save the cap so you can recap ink cartridges before storing or disposing of them.

**Caution:** Do not remove any other labels or seals, or ink will leak.
8. Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom of the ink cartridge down until it clicks into place.

![Inserting ink cartridge](image)

9. Once you replace all the cartridges that need replacing, close the scanner unit.

![Closing scanner unit](image)

The product starts priming the ink. This takes a few minutes. When you see a completion message on the LCD screen, ink replacement is complete.

**Note:** Do not turn off the product while it is priming or you will waste ink. If you see an error screen telling you an ink cartridge is installed incorrectly, lift up the scanner unit and press the ink cartridge down until it clicks into place. When you're finished, close the scanner unit.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

**Caution:** If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink. Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges
Related concepts
Purchase Epson Ink Cartridges

Printing With Black Ink and Expended Color Cartridges
When a color ink cartridge is expended, you can temporarily continue printing from your computer using black ink. Replace the expended color cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing With Expended Color Cartridges - Windows
Printing With Expended Color Cartridges - Mac OS X
Parent topic: Replacing Ink Cartridges
Related tasks
Removing and Installing Ink Cartridges

Printing With Expended Color Cartridges - Windows
If you see a message during printing telling you that you can temporarily print in black ink with an expended color cartridge, you can cancel your print job and select settings to print on plain paper or on an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.

1. Click Cancel or Cancel Print to cancel your print job.

   Note: If the message screen appears on another computer on a network, you may need to cancel the print job using the product control panel.

2. Load plain paper or an envelope in your product.
3. Access the print settings in your print application.
4. Click the Main tab.
5. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
6. Select the **Black/Grayscale** checkbox.

7. Click **OK**.

8. Print your document.
   Epson Status Monitor 3 displays a print message.

9. Click **Print in Black** to print your document.

**Parent topic:** Printing With Black Ink and Expended Color Cartridges

**Related topics**

Loading Paper

---

**Printing With Expended Color Cartridges - Mac OS X**

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink on plain paper or on an envelope.

1. Click the printer icon in the Dock.

2. If you see a message telling you that you can temporarily print with only black ink, click the **Delete** icon to cancel your print job.

   **Mac OS X 10.8:** Click the **button to cancel your print job. If an error message is displayed, click the **OK** button.

   **Note:** If the message screen appears on another computer on a network, you may need to cancel the print job using the product control panel.

3. In the Apple menu or the Dock, select **System Preferences**.

4. Select **Print & Fax** or **Print & Scan**, select your product, and select **Options & Supplies**.

5. Select **Driver**.
   You see this screen:
6. Select On as the **Permit temporary black printing** setting.
7. Click **OK**.
8. Close the utility window.
9. Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
11. Select **Print Settings** from the pop-up menu.
12. Select **Plain Paper/Bright White Paper** or **Envelope** as the paper type setting.
13. Select the **Grayscale** option.
14. Click **Print** to print your document.

**Parent topic:** Printing With Black Ink and Expended Color Cartridges

**Related topics**

- Loading Paper

---

**Conserving Low Black Ink with Windows**

The following window appears when black ink runs low and there is more color ink.
Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor must be enabled.

- Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink for the document you are printing.
- Click Disable this feature to continue using the remaining black ink.

Note: If you disable this feature, it remains disabled until you reinstall the black ink cartridge.

Parent topic: Replacing Ink Cartridges
Adjusting Print Quality

If your print quality declines, you may need to run a utility to clean or align the print head. If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Cleaning the Paper Path

Related topics
Replacing Ink Cartridges

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Setup.
5. Select Maintenance.

6. Select Nozzle Check.

7. Press the start button.
The nozzle check pattern is printed.

8. Check the printed pattern to see if there are gaps in the lines.

**Print head is clean**

```
  _ _ _ _ _ _ _ _
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
```

**Print head needs cleaning**

```
  _ _ _ _ _ _ _ _
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
  | | | | | | | |
```

9. Do one of the following:
   - If there are no gaps, the print head is clean. Select **Done**.
   - If there are gaps or the pattern is faint, select **Clean the Print Head**.

10. Follow the instructions on the screen to clean the print head.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** [Print Head Nozzle Check](#)

**Related tasks**
- [Loading Paper in Cassette 2 (Lower Cassette)](#)
- [Cleaning the Print Head Using the Product Control Panel](#)

**Related topics**
- [Replacing Ink Cartridges](#)

### Checking the Nozzles Using a Computer Utility

You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   • **Windows**: Right-click the product icon in the Windows taskbar.
   • **Mac OS X 10.6/10.7/10.8**: In the Apple menu or the Dock, select System Preferences. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility and select Open Printer Utility.
   • **Mac OS X 10.5**: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, select your product, and select Open Print Queue. Select Utility.
4. Select **Nozzle Check**.
   You see a window like this:

   ![Nozzle Check Window]

   To perform a nozzle check, make sure that the printer is on and connected to the computer. Make sure that the CD/DVD tray is removed and the output tray is ejected; otherwise, "Nozzle Check" cannot be performed. Also make sure that A4 or Letter size plain paper is loaded in the cassette 2. Click [Print] to print a nozzle check pattern or click [Cancel] to quit.

   ![Cancel and Print Buttons]

5. Click **Print**.
6. Check the printed pattern to see if there are gaps in the lines.

   Print head is clean

   ![Print head is clean pattern]

   Print head needs cleaning

   ![Print head needs cleaning pattern]

7. If there are no gaps, click **Finish**.
   If there are gaps or the pattern is faint, clean the print head.

   Parent topic: Print Head Nozzle Check
   Related tasks
   Loading Paper in Cassette 2 (Lower Cassette)
   Cleaning the Print Head Using a Computer Utility
   Related topics
   Replacing Ink Cartridges

**Print Head Cleaning**

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the print head.

   **Note:** You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it when a cartridge is low. You must replace the cartridge first.
Cleaning the Print Head Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select Setup.
5. Select Maintenance.
6. Select **Head Cleaning**.

7. Press the start button to clean the print head. You see a message on the LCD screen during the cleaning cycle.

   **Caution:** Never turn off the product during a cleaning cycle or you may damage it.

   When the cleaning cycle is finished, you see a message on the display screen.

8. Select **Print Nozzle Check Pattern**, then press the start button to run a nozzle check and confirm that the print head is clean.

   If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** [Print Head Cleaning](#)

**Related tasks**
- [Loading Paper in Cassette 2 (Lower Cassette)](#)
- [Checking the Nozzles Using the Product Control Panel](#)

**Related topics**
- [Replacing Ink Cartridges](#)

**Cleaning the Print Head Using a Computer Utility**

You can clean the print head using a utility on your Windows computer or Mac.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Do one of the following:
   • **Windows**: Right-click the product icon in the Windows taskbar.
   • **Mac OS X 10.6/10.7/10.8**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax** or **Print & Scan**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
   • **Mac OS X 10.5**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, select your product, and select **Open Print Queue**. Select **Utility**.
4. Select **Head Cleaning**.
   You see a window like this:

   ![Head Cleaning window](image)

   Make sure that the CD/DVD tray is removed and the output tray is ejected; otherwise “Head Cleaning” cannot be performed. Click [Start] to clean the print head nozzles. Because cleaning consumes some ink, only clean the print head when faint areas or gaps appear in your printout. Use the “Nozzle Check” utility first to confirm that the print head needs to be cleaned. If the ink is low or expended, replace the cartridge first.
   Caution: Do not insert CD/DVD tray until cleaning has finished.

   ![Start and Cancel buttons](image)

5. Click **Start** to begin the cleaning cycle.
You see a message on the LCD screen during the cleaning cycle.

**Caution:** Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click **Print Nozzle Check Pattern** and click **Print**.

7. Check the printed pattern to see if there are gaps in the lines.

   - **Print head is clean**
   - **Print head needs cleaning**

   If there are no gaps, click **Finish**.
   - If there are gaps or the pattern is faint, click **Clean** to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, turn off the product and wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or damaged and needs to be replaced.

**Parent topic:** Print Head Cleaning

**Related tasks**
- Loading Paper in Cassette 2 (Lower Cassette)
- Checking the Nozzles Using a Computer Utility
Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or light horizontal bands, you may need to align the print head.

**Note:** Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel

Aligning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

**Aligning the Print Head Using the Product Control Panel**

You can align the print head using the control panel on your product.

1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load a few sheets of plain paper in the product.
3. Press the home button, if necessary.
4. Select **Setup**.
5. Select **Maintenance**.
6. Select **Print Head Alignment**.

7. Press the $\bigcirc$ start button to print an alignment sheet.

   **Note:** Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the best printed pattern for each set.

9. Select **Done** when you are finished.

**Parent topic:** Print Head Alignment

**Related tasks**

- **Loading Paper in Cassette 2 (Lower Cassette)**
- **Aligning the Print Head Using a Computer Utility**

**Aligning the Print Head Using a Computer Utility**

You can align the print head using a utility on your Windows computer or Mac.

1. Make sure the CD/DVD tray is not inserted for printing.

2. Load a few sheets of plain paper in the product.

3. Do one of the following:

   - **Windows**: Right-click the product icon in the Windows taskbar.
   - **Mac OS X 10.6/10.7/10.8**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax** or **Print & Scan**, select your product, and select **Options & Supplies**. Select **Utility** and select **Open Printer Utility**.
• **Mac OS X 10.5**: In the Apple menu or the Dock, select **System Preferences**. Select **Print & Fax**, select your product, and select **Open Print Queue**. Select **Utility**.

4. Select **Print Head Alignment**.
5. Click **Next**, then click **Print** to print an alignment sheet.

   **Note**: Do not cancel printing while you are printing a head alignment pattern.

   You see a window like this:

![Print Head Alignment](image)

6. Check the printed pattern and follow the instructions on the screen to choose the number representing the best printed pattern for each set.
   - After choosing each pattern number, click **Next**.
• If no patterns are aligned in one or more of the sets, choose the closest one in each set and click **Realignment**. Then print another alignment sheet and check it.

**Note:** Click **Skip** (where available) if you want to skip a particular alignment sheet.

7. When you are done, click **Finish**.

**Parent topic:** Print Head Alignment

**Related tasks**

Loading Paper in Cassette 2 (Lower Cassette)

---

**Cleaning the Paper Path**

If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.

1. Load a few sheets of plain paper in the product.
2. Use the product control panel to make a copy, but without placing a document on the scanner glass.
3. Check the back of the ejected paper to see if it is clean.
4. Repeat as necessary until the paper comes out clean.

**Parent topic:** Adjusting Print Quality

**Related tasks**

Loading Paper in Cassette 2 (Lower Cassette)
Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.

Close the output tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it. Do not use oil or other lubricants inside the product or let water get inside it.

1. Turn off the product.
2. Unplug the power cable.
3. Disconnect any connected cables.
4. Remove all the paper.
5. Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with any force.

6. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.

Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to ship your product or transport it a long distance, prepare it for transportation as described here.

Caution: During transportation and storage, follow these guidelines:

• Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
• Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
  the product from printing.
• Do not carry the product by its control panel; this may damage the product.

1. Turn off the product.
2. Lift up the scanner unit and check to see if the print head is in the far right position (the home
   position). If not, turn on the product, wait for the print head to move, then turn the product off again.

   Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
   your product.

4. Lower the scanner unit.
5. Remove all the paper from the product.
6. Unplug the power cable.
7. Disconnect any connected cables.
8. Close the rear paper feed slot cover and the output tray. Then lower the control panel.

9. Place the product in its original packing materials, if possible, or use equivalent materials with cushioning around the product.

Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder before turning on your product. If print quality has declined when you print again, clean and align the print head.

**Parent topic:** Cleaning and Transporting Your Product

**Related concepts**
- Print Head Cleaning
- Print Head Alignment
Solving Problems

Check these sections for solutions to problems you may have using your product.

Check for Software Updates
Product Status Messages
Running a Product Check
Resetting Control Panel Defaults
Solving Setup Problems
Solving Network Problems
Solving Copying Problems
Solving Paper Problems
Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems
Solving Scanning Problems
Solving Scanned Image Quality Problems
Solving Memory Card Problems
When to Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software. You can select Download the Latest Software from the Home screen of this manual or visit Epson's driver download site (U.S. downloads or Canadian downloads).

With Windows, your printer software automatically checks for updates. You can also manually update the software by selecting Software Update here:

- Right-clicking the product icon in the Windows taskbar
- On the Maintenance tab in the printer settings window
- On the Start screen (Windows 8) or in the EPSON program group under your product name (other Windows versions)

Parent topic: Solving Problems
You can often diagnose problems with your product by checking the messages on its LCD screen. You can also see help information and how-to instructions on the screen. Press the home button, if necessary, press the left or right arrow button, and then select Help.

<table>
<thead>
<tr>
<th>LCD screen message</th>
<th>Condition/solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper jam</td>
<td>Paper is jammed in the product. Follow the instructions on the LCD screen to remove the jammed paper from the indicated area.</td>
</tr>
<tr>
<td>Paper out</td>
<td>No paper is loaded. Load paper in the product.</td>
</tr>
<tr>
<td>Photos not recognized. Place the photos correctly on the scanner glass.</td>
<td>There is a problem with originals placed on the product. Check to make sure they are placed correctly and repeat the operation.</td>
</tr>
<tr>
<td>Printer error. Turn the power off and on again. For details, see your documentation.</td>
<td>A fatal error has occurred. Turn the product off and then back on again. If the error continues, check for a paper jam. If there is no paper jam, contact Epson for support.</td>
</tr>
<tr>
<td>Communication error. Check if a computer is connected.</td>
<td>Make sure the computer is connected to your product and your scanning software is installed correctly.</td>
</tr>
<tr>
<td>A printer's ink pad is nearing the end of its service life. Contact Epson Support.</td>
<td>The ink pads are near the end of their service life and the message will be displayed until the ink pad is replaced. Contact Epson for support. (To resume printing, press the start button.)</td>
</tr>
<tr>
<td>A printer's ink pad is at the end of its service life. Contact Epson Support.</td>
<td>The ink pad is at the end of its service life. Turn off the product and contact Epson for support.</td>
</tr>
<tr>
<td>Memory card or external device not recognized.</td>
<td>Make sure the memory card or external device is inserted correctly and meets the specifications for your product.</td>
</tr>
<tr>
<td>LCD screen message</td>
<td>Condition/solution</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Combination of IP address and subnet mask is invalid.</td>
<td>There is a problem with the network connection to your product.</td>
</tr>
<tr>
<td>Recovery mode</td>
<td>An error has occurred during firmware updating. Connect your product using a USB cable and try downloading the Firmware Update from Epson's support website. If you still need help, contact Epson for support.</td>
</tr>
</tbody>
</table>

**Note:** The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages. During the life of your product it may reach a condition where either satisfactory print quality cannot be maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your LCD, or lights on the control panel will advise you when these parts need replacing. If this happens during the standard warranty of the product, the exchange of the product or replacement of the pads is covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any Epson authorized service provider. The waste ink pads are not a user-replaceable part.

**Parent topic:** Solving Problems

**Related references**

Where to Get Help

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette

Paper Jam Problems in the Auto Duplexer

**Related tasks**

Placing Originals on the Scanner Glass

**Related topics**

Loading Paper

Solving Network Problems

**Running a Product Check**

Running a product check helps you determine if your product is operating properly.

1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the home button, if necessary.
4. Select **Setup**.

5. Select **Maintenance**.

![Maintenance Menu]

6. Select **Nozzle Check**.

![Nozzle Check Menu]

7. Press the ◇ start button.
   The nozzle check pattern is printed.

8. Do one of the following, depending on the results of the product check:
   • If the page prints and the nozzle check pattern is complete, the product is operating properly. Any operation problem you may have could be caused by your computer, cable, software, or selected...
settings. Check the other solutions in this book or try uninstalling and reinstalling your printer software.

- If the page prints but the nozzle check pattern has gaps, clean or align the print head.
- If the page does not print, the product may have a problem. Check the other solutions in this manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

- When to Uninstall Your Product Software
- Print Head Cleaning
- Print Head Alignment

Related references

- Where to Get Help

**Resetting Control Panel Defaults**

If you have a problem with settings on the product control panel, you can reset them to their factory defaults. You can choose which settings to reset or reset them all.

1. Press the home button, if necessary.
2. Select Setup.
3. Scroll down and select **Restore Default Settings**.
4. Select one of these options:
   • **Wi-Fi/Network Settings**: Resets all network settings.
   • **All except Wi-Fi/Network Settings**: Resets all control panel settings, except for network settings.
   • **All Settings**: Resets all control panel settings.
   You see a confirmation screen.

5. Select **Yes** to reset the selected settings. (Select **No** if you want to cancel the operation.)

**Parent topic:** Solving Problems

### Solving Setup Problems

Check these sections if you have problems while setting up your product.

- **Noise After Ink Installation**
- **Software Installation Problems**
- **Control Panel Setup Problems**

**Parent topic:** Solving Problems

### Noise After Ink Installation

If you hear noises from your product after installing ink, check the following:

- The first time you install ink cartridges, the product must prime its print head. Wait until priming finishes before you turn off the product, or it may prime improperly and use excess ink the next time you turn it on. Your product is finished priming the print head when the power light stops flashing.

- If the product's print head stops moving or making noise, and the charging process has not finished after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still in progress. If it is still in progress, contact Epson for help.

**Parent topic:** Solving Setup Problems

**Related references**

- **Where to Get Help**

### Software Installation Problems

If you have problems while installing your product software, try these solutions:

- Make sure your product is turned on and any necessary cables are securely connected at both ends. If you still have problems installing software, disconnect the cable and carefully follow the instructions on the *Start Here* sheet. Also make sure your system meets the requirements for your operating system.
• Close any other programs, including screen savers and virus protection software, and install your product software again.

• In Windows, make sure your product is selected as the default printer and the correct port is shown in the printer properties.

• If you see any error message or your software does not install correctly in Windows, you may not have software installation privileges. Contact your System Administrator.

**Parent topic:** Solving Setup Problems

**Related concepts**

When to Uninstall Your Product Software

**Related references**

Windows System Requirements

Mac System Requirements

---

**Control Panel Setup Problems**

If you have problems setting up the control panel, try these solutions:

• To view LCD screen text in a different language, select a different language setting for the panel.

• To adjust the position of the control panel, carefully raise or lower it.

**Parent topic:** Solving Setup Problems

**Related tasks**

Adjusting Control Panel Position

Changing LCD Screen Language

---

**Solving Network Problems**

Check these solutions if you have problems setting up or using your product on a network.

**Note:** Breakdown or repair of this product may cause loss of network data and settings. Epson is not responsible for backing up or recovering data and settings during or after the warranty period. We recommend that you make your own backup or print out your network data and settings.

**Product Cannot Connect to a Wireless Router or Access Point**

**Network Software Cannot Find Product on a Network**

**Product Does Not Appear in Mac OS X Printer Window**

**Cannot Print Over a Network**
Cannot Scan Over a Network
Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

• Make sure to place your product within contact range of your router or access point.

  Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

• Verify that your router or access point is operating correctly by connecting to it from your computer or another device.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

• Check to see if access restrictions, such as MAC address filtering, are set on the router or access point. If access restrictions are set, add your product’s MAC address to your router’s address list. To obtain your product’s MAC address, print a network status sheet. Then follow the instructions in your router or access point documentation to add the address to the list.

• If your router or access point does not broadcast its network name (SSID), follow the instructions that came with your product to enter your wireless network name manually.

• If your router or access point has security enabled, determine the kind of security it is using and any required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA passphrase correctly.

• Check if your computer is restricting the available wireless channels. If so, verify that your wireless access point is using one of the usable channels and change to a usable channel, if necessary.

• If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on your device may have been changed. If necessary, delete the existing DIRECT-xxxxxxxx connection settings from your device and enter a new password. See your device documentation for instructions.

• If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the network connection or adapter settings in the Windows Control Panel and set the Internet metric setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems
Network Software Cannot Find Product on a Network

If EpsonNet Setup cannot find your product on a network, try these solutions:

• Make sure your product is turned on and connected to your network. Verify connection using your product control panel.

• Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-ASCII characters.

• If necessary, reinstall your product software and try running EpsonNet Setup again:
  1. Reset your product's network settings to their factory defaults.
  2. Windows only: uninstall your product software.
  3. Initialize your router following the instructions in your router documentation.

  Note: If you are reading these instructions online, you will lose your internet connection when you initialize your router, so note the next step before initializing it.

  4. Download your product software from the Epson website, or install it from the CD that came with your product using the instructions on the Start Here sheet.

• If you have replaced your router, reinstall your product software to connect to the new router.

Parent topic: Solving Network Problems
Related concepts
When to Uninstall Your Product Software
Related tasks
Resetting Control Panel Defaults

Product Does Not Appear in Mac OS X Printer Window

If your product does not appear in the Mac OS X printer window, try these solutions:

• Turn your product off, wait 30 seconds, then turn it back on again.

• If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna icon with connection bars on your LCD screen, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems
Related concepts
When to Uninstall Your Product Software
Cannot Print Over a Network

If you cannot print over a network, try these solutions:

- Make sure that your product is turned on.
- Make sure you install your product's network software as described in your product documentation.
- Print a network status sheet and verify that the network settings are correct. If the network status is **Disconnected**, check any cable connections and turn your product off and then on again.
- If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your network does not assign IP addresses using DHCP, set the IP address manually.
- Make sure your computer and product are both using the same wireless network.
- If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place your product closer to your router or access point.

  **Note:** Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

- Check your wired LAN router or access point to see if the LED for the port to which your product is connected is on or flashing. If the link LED is off, try the following:
  - Make sure the Ethernet cable is securely connected to your product and to your router, access point, switch, or hub.
  - Try connecting your product to a different port or a different router, access point, switch, or hub.
  - Try connecting with a different Ethernet cable.
  - Try printing to your product from another computer on the network.
  - If you are connecting the product via EpsonNet Setup and the Wi-Fi icon and signal bars are not visible on the LCD, make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts

- When to Uninstall Your Product Software

Related tasks

- Printing a Network Status Sheet
Cannot Scan Over a Network

If you cannot start Epson Scan for scanning over a network, try these solutions:

• If you are scanning a large original at a high resolution, a network communication error may occur. Try scanning again at a lower resolution.

• If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try restarting Epson Scan again.

• Check the connection setting and test the connection using Epson Scan Settings:
  
  **Windows 8**: Navigate to the **Start** screen and select **EPSON Scan Settings**. Make sure the **Connection** setting is set to **Network**, then click the **Test** button.

  **Windows (other versions)**: Click or **Start > All Programs** or **Programs > EPSON > EPSON Scan > EPSON Scan Settings**. Make sure the **Connection** setting is set to **Network**, then click the **Test** button.

  **Mac OS X**: Open the **Applications** folder, click **Epson Software**, and click **EPSON Scan Settings**. Make sure the **Connection** setting is set to **Network**, then click the **Test** button.

• Make sure the option selected as the **Timeout Setting** in the Epson Scan Settings program is long enough to complete scanning over a network.

• You may need to disable the firewall and any anti-virus software on your wireless router or access point.

**Note**: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems

Solving Copying Problems

Check these solutions if you have problems copying with your product.

**Product Makes Noise, But Nothing Copies**

**Product Makes Noise When It Sits for a While**

Parent topic: Solving Problems
Product Makes Noise, But Nothing Copies

If your product makes a noise, but nothing copies, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• If the nozzle check page does not print, but the product's power is on, make sure your product software is installed correctly.
• Make sure your product is level (not tilted).

Parent topic: Solving Copying Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.

Parent topic: Solving Copying Problems

Solving Paper Problems

Check these sections if you have problems using paper with your product.

Paper Feeding Problems
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems

If you have problems feeding paper, try these solutions:

• If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the cassette. Make sure to load only one sheet at a time in the rear feed slot.
• If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
• Do not load more than the recommended number of sheets.
• Make sure your paper meets the specifications for your product.
• If paper jams when you print on both sides of the paper, try loading fewer sheets.
• For best results, follow these guidelines:
  • Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
  • Load paper in the cassette printable side down.
  • Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Related references
Paper Loading Capacity
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer

Paper Jam Problems Inside the Product

If you see a message that paper has jammed inside the product, follow the steps below or on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
3. Lift the scanner unit and remove any jammed paper inside.
Caution: Do not touch the flat white cable inside the printer.

4. Close the scanner unit.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
- Paper Jam Problems in the Paper Cassette
- Paper Jam Problems in the Auto Duplexer

**Paper Jam Problems in the Paper Cassette**

If you see a message that paper has jammed in the paper cassette, follow the steps below or on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.
2. Pull out both paper cassettes, then carefully remove any jammed paper.

3. Make sure the paper you loaded is under the edge guides.

4. Keep the cassette flat as you insert it. If inserting Cassette 1 (upper cassette), insert it until the arrows on the right side line up.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Auto Duplexer

Paper Jam Problems in the Auto Duplexer

If you see a message that paper has jammed in the auto duplexer, follow the steps below or on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.

2. Press the buttons to release the auto duplexer and remove the duplexer from your product. Carefully remove any jammed paper from inside the unit.
3. Remove any jammed paper from the duplexer.

4. Open the duplexer and remove any jammed paper from inside it.
5. Reattach the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam message, check the other paper jam solutions.

Parent topic: Solving Paper Problems
Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:
- If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper. Select the correct paper size when you reprint.
- If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems
Related references
Paper or Media Type Settings
Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Nothing Prints
Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement
Printing is Slow

Parent topic: Solving Problems

Nothing Prints

If you have sent a print job and nothing prints, try these solutions:

• Make sure your product is turned on.
• Make sure any interface cables are connected securely at both ends.
• If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print, connect your product directly to your computer instead of the hub.
• Run a product check to see if a test page prints. If the test page prints, check to see if your product software is installed correctly.
• In Windows, make sure your product is selected as the default printer.
• In Windows, clear any stalled print jobs from the Windows Spooler:

  • **Windows 8**: Navigate to the Start screen, right-click the screen, and select All apps. Select Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name, select See what’s printing, and select your product name again if necessary. Right-click the stalled print job, click Cancel, and click Yes.
  
  • **Windows 7**: Click and select Devices and Printers. Right-click your product name, select See what’s printing, and select your product name again, if necessary. Right-click the stalled print job, click Cancel, and click Yes.
  
  • **Windows Vista**: Click and select Control Panel. Click Printer under Hardware and Sound, right-click your product name, and select Open. Right click the stalled print job, click Cancel, and click Yes.
  
  • **Windows XP**: Click Start and select Printers and Faxes. (Or open the Control Panel, select Printers and Other Hardware, if necessary, and select Printers and Faxes.) Right-click your product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer
Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar
If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does not work, try this solution:
1. Do one of the following:
   - Windows 8: Navigate to the Start screen, right-click the screen and select All apps. Select Control Panel > Hardware and Sound > Devices and Printers.
   - Windows 7: Click and select Devices and Printers.
   - Windows Vista: Click , select Control Panel, and click Printer under Hardware and Sound.
   - Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select Printers and Other Hardware, if necessary, and Printers and Faxes.)
2. Right-click your product name, select Printing Preferences, and select your product name again if necessary.
3. Click the Maintenance tab.
4. Click the Extended Settings button.
5. Click the Monitoring Preferences button.
6. Click the Register the shortcut icon to the taskbar checkbox.
7. Click OK to close the open program windows.

Error After Cartridge Replacement
If you see an error light or error message after you replace an ink cartridge, follow these steps:
1. Make sure the print head is in the ink cartridge replacement position. (The ink cartridge holder should be beneath the cutout in the product case.)
   Note: If the print head is not in the ink cartridge replacement position, follow the instructions on replacing an ink cartridge in this manual to move it.
2. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.
Printing is Slow

If printing becomes slow, try these solutions:

- Make sure your system meets the requirements for your operating system. If you are printing a high-resolution image, you may need more than the minimum requirements. If necessary, increase your system's memory.
- If you are using Windows 7, close the Devices and Printers window before you print.
- Clear space on your hard drive or run a defragmentation utility to free up existing space.
- Close any programs you are not using when you print.
- If your product is connected to a USB hub, connect it directly to your computer instead.
- If printing becomes slower after printing continuously for a long time, the product may have automatically slowed down to protect the print mechanism from overheating or becoming damaged. Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

- Make sure the paper type setting matches the type of paper you loaded.
- Turn on any high speed settings in your product software.
- Select a lower print quality setting.
- Make sure the ink drying time has not been increased for double-sided printing.
- **Windows**: Click the Maintenance tab, select Extended Settings, and select the following settings:
  - High Speed Copies
  - Always spool RAW datatype
  - Page Rendering Mode
  - Print as Bitmap
Solving Page Layout and Content Problems

Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image
Too Many Copies Print
Blank Pages Print
Incorrect Margins on Printout
Border Appears on Borderless Prints
Incorrect Characters Print
Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image

If your printed image is inverted unexpectedly, try these solutions:

• Turn off any mirror or inversion settings in your printing application.
• Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Too Many Copies Print
Make sure that the Copies setting in your printing program or printer software is not set for multiple copies.

Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:

• Make sure you selected the correct paper size settings in your printing program and printer software.
• If a blank page exists in a document you are printing and you want to skip printing it, select the Skip Blank Page setting in your printer software.
• Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if necessary.
• Make sure your product is selected as the printer in your printing program.

Parent topic: Solving Page Layout and Content Problems
Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Printing Preferences - Mac OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:

• Make sure you selected the correct paper size settings in your printing program and printer software.
• Make sure you selected the correct margins for your paper size in your printing program.
• Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.

Parent topic: Solving Page Layout and Content Problems
Related tasks
Selecting Print Layout Options - Windows
Border Appears on Borderless Prints

If you see a border on borderless prints, try these solutions:

• Make sure you are printing on a compatible borderless paper type and size.

  **Note**: Do not select a custom paper size for borderless prints.

• **Windows**: Make sure you selected the **Borderless** setting in your printer software.

• **Mac OS X**: Make sure you selected the **Borderless** checkbox or a paper size with a **Borderless** option in your printer software.

• Adjust the **Expansion** setting to adjust the amount of image expansion on the edges of borderless prints.

• Make sure the image size and the paper size are set correctly; if the image is small, the enlargement may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems

Related references

Borderless Paper Type Compatibility

Related tasks

Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X

Incorrect Characters Print

If incorrect characters appear in your prints, try these solutions before reprinting:

• Make sure any cables are securely connected at both ends.

• In Windows, delete all print jobs from the Windows Spooler:
  
    • **Windows 8**: Navigate to the **Start** screen, right-click the screen, and select **All apps**. Select **Control Panel > Hardware and Sound > Devices and Printers**. Right-click your product name,
select **See what’s printing**, and select your product name again, if necessary. Right-click the stalled print job, click **Cancel**, and click **Yes**.

- **Windows 7**: Click ![ioxid](image) and select **Devices and Printers**. Right-click your product name, select **See what’s printing**, and select your product name again, if necessary. Right-click the stalled print job, click **Cancel**, and click **Yes**.

- **Windows Vista**: Click ![oxid](image) and select **Control Panel**. Click **Printer** under **Hardware and Sound**, right-click your product name, and select **Open**. Right click the stalled print job, click **Cancel**, and click **Yes**.

- **Windows XP**: Click **Start** and select **Printers and Faxes**. (Or open the **Control Panel**, select **Printers and Other Hardware** if necessary, and select **Printers and Faxes**.) Right-click your product name, select **Open**, right-click the stalled print job, click **Cancel**, and click **Yes**.

- Make sure your product is selected as the printer in your printing program.
- If your product is connected to a USB hub, connect it directly to your computer instead.

**Parent topic:** Solving Page Layout and Content Problems

### Incorrect Image Size or Position

If your printed image is the wrong size or in the wrong position, try these solutions:

- Make sure you selected the correct paper size and layout settings in your printing program and printer software.
- Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.

**Parent topic:** Solving Page Layout and Content Problems

**Related tasks**

- [Selecting Basic Print Settings - Windows](#)
- [Selecting Print Layout Options - Windows](#)
- [Selecting Basic Print Settings - Mac OS X](#)
- [Selecting Page Setup Settings - Mac OS X](#)

### Slanted Printout

If your printouts are slanted, try these solutions:

- Slide the edge guides against the edges of the paper.
- Select a higher print quality setting in your printer software.
• Align the print head.
• Make sure the product is not printing while tilted or at an angle.

**Parent topic:** Solving Page Layout and Content Problems

**Related concepts**
Print Head Alignment

**Related tasks**
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

---

**Solving Print Quality Problems**

Check these sections if your printouts have problems with print quality, but your image looks fine on your computer screen.

- White or Dark Lines in Printout
- Blurry or Smeread Printout
- Faint Printout or Printout Has Gaps
- Grainy Printout
- Incorrect Colors

**Parent topic:** Solving Problems

**Related topics**
Solving Scanned Image Quality Problems

---

**White or Dark Lines in Printout**

If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure you loaded the printable side of the paper correctly for your product.
• Turn off any high speed settings in your product software.
• Align the print head.
• You may need to replace the ink cartridges.

**Parent topic:** Solving Print Quality Problems
Blurry or Smeared Printout

If your printouts are blurry or smeared, try these solutions:

• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Use a support sheet with special paper, or load special paper one sheet at a time.
• Make sure your paper meets the specifications for your product.
• Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.
• Make sure the paper type setting in your product software matches the type of paper you loaded.
• Remove each sheet from the output tray as it is printed.
• Avoid handling printouts on glossy paper right after printing to allow the ink to set.
• Turn off any high speed settings in your product software.
• If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first. Adjust the Print Density and/or Increased Ink Drying Time settings.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• Clean the paper path.
Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Cleaning
Print Head Alignment

Related references
Printing Preferences - Mac OS X
Paper Specifications

Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Double-sided Printing Settings - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Double-sided Printing Settings - Mac OS X
Cleaning the Paper Path

Related topics
Loading Paper

Faint Printout or Printout Has Gaps

If your printouts are faint or have gaps, try these solutions:

• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Make sure the paper type setting matches the type of paper you loaded.
• Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
• Align the print head.
• Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Grainy Printout

If your printouts are grainy, try these solutions:

• Make sure you loaded the printable side of the paper correctly for your product.
• Select a higher print quality setting and turn off any high speed settings in your product software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• Align the print head.
• You may need to increase the image resolution or print a smaller size; see your software documentation.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Printing Preferences - Mac OS X

Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
Incorrect Colors

If your printouts have incorrect colors, try these solutions:

• Make sure the **Black/Grayscale** or **Grayscale** setting is not selected in your printer software.
• Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if necessary.
• The ink cartridges may be old or low on ink, and you may need to replace them.
• Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Try using the color management options in your printer software.
• For best results, use genuine Epson ink and paper.

**Parent topic:** Solving Print Quality Problems

**Related concepts**

Print Head Cleaning
Print Head Alignment

**Related tasks**

Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
Managing Color - Mac OS X

Solving Scanning Problems

Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan

**Parent topic:** Solving Problems
Scanning Software Does Not Operate Correctly

If your scanning software does not operate correctly, try these solutions:

• Make sure your computer has adequate memory and meets the system requirements for your operating system.

• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart your scanning software.

• If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

  Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems
Related concepts
When to Uninstall Your Product Software
Related references
Windows System Requirements
Mac System Requirements
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Cannot Start Epson Scan

If you cannot start Epson Scan, try these solutions:

• Make sure your product is turned on and any interface cables are securely connected at both ends.

• Make sure Epson Scan is selected in your scanning program.

• Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so, wake your system and restart Epson Scan.

• Check the connection setting and test the connection using Epson Scan Settings:

  Windows 8: Navigate to the Start screen and select EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the Test button.
Windows (other versions): Click 🌟 or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the Test button.

Mac OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the Test button.

- Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions and install one version.
- If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems

Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Related topics
Starting a Scan

Solving Scanned Image Quality Problems

Check these sections if a scanned image on your computer screen has a quality problem.

- Image Consists of a Few Dots Only
- Line of Dots Appears in All Scanned Images
- Straight Lines in an Image Appear Crooked
- Image is Distorted or Blurry
- Image Colors are Patchy at the Edges
- Image is Too Dark
- Back of Original Image Appears in Scanned Image
- Ripple Patterns Appear in an Image
- Scanned Image Colors Do Not Match Original Colors
- Scan Area is Not Adjustable in Thumbnail Preview
- Scanned Image Edges are Cropped
Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
  • Make sure you placed your original for scanning facing the correct way.
  • If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and scan again.

Line of Dots Appears in All Scanned Images
If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Straight Lines in an Image Appear Crooked
If straight lines in an original appear crooked in a scanned image, make sure to place your original straight when you scan it.
Related tasks
Placing Originals on the Scanner Glass

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:
• Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the scanner glass.
• Do not move your original or your product during scanning.
• Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that extends beyond the base of the product in all directions.
• Adjust these Epson Scan settings (if available) and try scanning again:
  • Select the Unsharp Mask setting.
  • Adjust the Auto Exposure setting.
  • Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges
If you are scanning a thick or warped original, cover its edges with paper to block external light as you scan it.

Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark
If your scanned image is too dark, try these solutions:
• Adjust these Epson Scan settings (if available) and try scanning again:
  • Auto Exposure
  • Brightness
  • Histogram Adjustment
• Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems
Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, place a piece of black paper on the back of the original and scan it again.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré) in scanned images of printed documents. This is caused by interference from differing pitches in the scanner's screen and your original's halftone screen. To reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:

- Select the Descreening setting.
- Select a lower Resolution setting.

Parent topic: Solving Scanned Image Quality Problems

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try scanning again:

- Change the Image Type setting and experiment with different combinations of the next settings.
- Adjust the Tone Correction setting.
- Adjust the Auto Exposure setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings
Scan Area is Not Adjustable in Thumbnail Preview

If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:

- Create a scan area by drawing a marquee on your preview image and adjusting it as necessary.
- Switch to Normal preview mode, if available, and preview your image again.

Parent topic: Solving Scanned Image Quality Problems

Related concepts
Image Preview Guidelines

Related tasks
Selecting a Scan Area - Home Mode
Selecting a Scan Area - Office Mode
Selecting a Scan Size - Professional Mode

Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Placing Originals on the Scanner Glass

Solving Memory Card Problems

Check these solutions if you have problems using memory cards with your product.

Memory Card Does Not Fit Into a Slot
Cannot View or Print Photos from a Memory Card
Cannot Transfer Photos To or From a Memory Card

Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot

If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with your memory card.

Parent topic: Solving Memory Card Problems
Cannot View or Print Photos from a Memory Card

If you cannot view or print photos from a memory card inserted in your product, try these solutions:

- Make sure you have inserted only one memory card at a time.
- Make sure your memory card is compatible with the product.
- Make sure the files on your memory card are in the correct format.
- If you have too many photos on your memory card, you may not see all the photos you expect or may be prompted to select a group of photos by date. Reduce the number of photos on your card or select one group of photos at a time. Check the memory card specifications for the maximum number of photos.

Parent topic: Solving Memory Card Problems

Related references
Memory Card Types
Memory Card File Specifications

Related tasks
Inserting a Memory Card

Cannot Transfer Photos To or From a Memory Card

If you have problems transferring photos to or from a memory card inserted in your product, try these solutions:

- Make sure you have inserted only one memory card at a time.
- Make sure your memory card is compatible with the product.
- Make sure your product is securely connected to your computer.
- If you are transferring photos to the memory card, check the memory card's write-protect tab to make sure it is set to allow writing to the card.
- Make sure that the file sharing setting for your product is set correctly.

Parent topic: Solving Memory Card Problems

Related references
Memory Card Types
Memory Card File Specifications

Related tasks
Inserting a Memory Card
When to Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac OS X

Parent topic: Solving Problems

Uninstalling Product Software - Windows

You can uninstall and then re-install your product software to solve certain problems.

1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

   - **Windows 8**: Navigate to the Start screen, right-click the screen, and select All apps. Select Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.

     Note: If you see a User Account Control window, click Yes or Continue.

     Select your product again, if necessary, then select OK, and click Yes to confirm the uninstallation.

   - **Windows (other versions)**: Click or Start, and select All Programs or Programs. Select EPSON, select your product, then click EPSON Printer Software Uninstall.

     Note: If you see a User Account Control window, click Yes or Continue.

     In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
   - **Windows 8**: Select **Epson Event Manager** and click **Uninstall**.
   - **Windows 7 or Windows Vista**: Open the Windows **Control Panel** utility. Select **Programs and Features**. (In Classic view, select **Programs** and click **Uninstall a program**.) Select **Epson Event Manager** and click **Uninstall/Change**.
   - **Windows XP**: Open the Windows **Control Panel** utility. Double-click **Add or Remove Programs**. Select **Epson Event Manager** and click **Change/Remove**.

5. Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:
   - **Windows 8, Windows 7, or Windows Vista**: Select **EPSON Scan** and click **Uninstall/Change**.
   - **Windows XP**: Select **EPSON Scan** and click **Change/Remove**.

6. Restart your computer, then see the **Start Here** sheet to re-install your software.

   **Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

**Parent topic:** [When to Uninstall Your Product Software](#)

### Uninstalling Product Software - Mac OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you can download the Uninstaller utility from the Epson support website to uninstall your product software as described here.

**Note**: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site ([U.S. downloads](#) or [Canadian downloads](#)).
2. Follow the instructions on the screen to install the Uninstaller utility.
3. Quit all applications currently running on your Mac.
4. Double-click the **Uninstaller** icon.
5. Select the checkbox for each software program you want to uninstall.
6. Click **Uninstall**.
7. Follow the on-screen instructions to uninstall the software.
8. To reinstall your product software, see the **Start Here** sheet for instructions.
Note: If you uninstall the printer driver and your product name remains in the Print & Fax or Print & Scan window, select your product name and click the – (remove) icon to remove it.

Parent topic: When to Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson’s support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

• Product name
• Product serial number (located on a label on the product)
• Proof of purchase (such as a store receipt) and date of purchase
• Computer configuration
• Description of the problem

Then call:
• U.S.: (562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday
• Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S. sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to epson.com/recycle for information on how to return your products for proper disposal.

Windows System Requirements
Mac System Requirements
Printing Specifications
Scanning Specifications
Paper Specifications
Printable Area Specifications
Ink Cartridge Specifications
Memory Card Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating systems:

• Windows 8
• Windows 7
• Windows Vista
• Windows XP Professional x64 Edition
• Windows XP SP3
Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:

- Mac OS X 10.5.8
- Mac OS X 10.6.x
- Mac OS X 10.7.x
- Mac OS X 10.8.x

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Printing Specifications

Paper path
- Paper cassette 1 (upper) and cassette 2 (lower), front entry
- Rear paper feed slot, top entry

Capacity
- **Cassette 1:**
  - 0.24 inch (6.0 mm) thick stack
  - Approximately 100 sheets at 20 lb (75 g/m²)
- **Cassette 2:**
  - 0.43 inch (11.0 mm) thick stack
  - Approximately 20 sheets of Epson Premium Photo Paper Glossy

Rear Paper Feed Slot:
- One sheet between 0.002 (0.05 mm) to 0.024 inch (0.6 mm) thickness

Parent topic: Technical Specifications
### Scanning Specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scanner type</strong></td>
<td>Flatbed, color</td>
</tr>
<tr>
<td><strong>Photoelectric device</strong></td>
<td>CIS</td>
</tr>
<tr>
<td><strong>Effective pixels</strong></td>
<td>40800 × 56160 pixels at 4800 dpi</td>
</tr>
<tr>
<td><strong>Document size</strong></td>
<td>Maximum: 8.5 × 11.7 inches (216 × 297 mm)</td>
</tr>
<tr>
<td></td>
<td>Scanner glass: US letter or A4</td>
</tr>
<tr>
<td><strong>Scanning resolution</strong></td>
<td>4800 dpi (main scan)</td>
</tr>
<tr>
<td></td>
<td>4800 dpi (sub scan)</td>
</tr>
<tr>
<td><strong>Output resolution</strong></td>
<td>50 to 4800, 7200, and 9600 dpi</td>
</tr>
<tr>
<td></td>
<td>(50 to 4800 dpi in 1 dpi increments)</td>
</tr>
<tr>
<td><strong>Image data</strong></td>
<td>16 bits per pixel per color internal</td>
</tr>
<tr>
<td></td>
<td>8 bits per pixel per color external (maximum)</td>
</tr>
<tr>
<td><strong>Light source</strong></td>
<td>LED</td>
</tr>
</tbody>
</table>

**Parent topic:** [Technical Specifications](#)

### Paper Specifications

**Note:** Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson cannot guarantee the quality of any non-Epson brand or type of paper. Always test a sample of paper stock before purchasing large quantities or printing large jobs.
### Single-sheets

**Size**
- A4 (8.3 × 11.7 inches [210 × 297 mm])
- Letter (8.5 × 11 inches [216 × 279 mm])
- Legal (8.5 × 14 inches [216 × 357 mm])
- 4 × 6 inches (102 × 152 mm)
- 5 × 7 inches (127 × 178 mm)
- 8 × 10 inches (203 × 254 mm)
- A6 (4.1 × 5.8 inches [105 × 148 mm])
- 3.5 × 5 inches (89 × 127 mm)
- 16:9 wide (4 × 7.1 inches [102 × 181 mm])
- Half Letter (5.5 × 8.5 inches [140 × 279 mm])
- 11 × 14 inches (279 × 356 mm)
- 11 × 17 inches (279 × 432 mm)
- A3 (11.7 × 16.5 inches [297 × 420 mm])

**Paper types**
- Plain paper and paper distributed by Epson

**Thickness**
- 0.003 inch (0.08 mm) to 0.004 inch (0.11 mm)

**Weight**
- 17 lb (64 g/m²) to 24 lb (90 g/m²)

### Envelopes

**Size**
- No. 10 (4.1 × 9.5 inches [105 × 241 mm])

**Paper types**
- Plain bond paper

**Weight**
- 20 lb (75 g/m²) to 24 lb (90 g/m²)

### Printable Area Specifications

**Note:** When printing borderless, quality may decline in the expanded printable area.
Single sheets

1. Top: 0.12 inch (3.0 mm) minimum
2. Left: 0.12 inch (3.0 mm) minimum
3. Right: 0.12 inch (3.0 mm) minimum
4. Bottom: 0.12 inch (3.0 mm) minimum

Envelopes
**CD/DVDs**

**12-cm CD/DVDs**

1. 0.7 inch (18 mm) minimum inner margin
2. 4.7 inch (120 mm) maximum outer margin

**Note:** Avoid printing in the clear plastic areas of discs to prevent staining the disc or CD/DVD tray with ink.

**Parent topic:** Technical Specifications

**Ink Cartridge Specifications**

**Note:** We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.
The cartridges included with the printer are designed for printer setup and not for resale. After some ink is used for priming, the rest is available for printing. Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink remains in the cartridge after the "replace cartridge" indicator comes on.

**Color**
Black, Cyan, Magenta, Yellow, Light Cyan, Light Magenta

**Cartridge life**
Opened package: 6 months
Unopened package: do not use if the date on the package has expired

**Temperature**
Storage: -4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (–16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

**Note:** For best printing results, use up a cartridge within 6 months of opening the package.

**Parent topic:** Technical Specifications

---

**Memory Card Specifications**

**Note:** Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for details on using it.
Compatible types
- CompactFlash
- Microdrive
- Memory Stick Duo
- Memory Stick PRO Duo
- Memory Stick PRO-HG Duo
- Memory Stick Micro*
- MagicGate Memory Stick Duo
- SDXC
- SDHC
- SD
- miniSDHC*
- miniSD*
- microSDXC*
- microSDHC*
- microSD*

Media format DCF
DCF (Design rule for Camera File system) version 1.0 or 2.0 compliant

Voltage requirements
- 3.3 V
- Maximum current for CompactFlash and Microdrive: 500 mA

Dimension Specifications

Height
- Stored: 5.8 inches (148 mm)
- Printing: 11.6 inches (295 mm)

Width
- Stored: 18.9 inches (479 mm)
- Printing: 18.9 inches (479 mm)
### Depth
- Stored: 14.0 inches (356 mm)
- Printing: 26.3 inches (668 mm)

### Weight
- 19.4 lb (8.8 kg)
  (approx. weight without ink cartridges, power cord, and CD/DVD tray)

Parent topic: Technical Specifications

---

## Electrical Specifications

- **Power supply rating**: 100 to 120 V
- **Input voltage range**: 90 to 132 V
- **Rated frequency range**: 50/60 Hz
- **Input frequency range**: 49.5/60.5 Hz
- **Rated current**: 0.7 A
- **Power consumption**
  - Standalone copying: 21 W (ISO/IEC24712)
  - Ready mode: 7.0 W
  - Sleep mode: 1.4 W
  - Power off mode: 0.2 W

Parent topic: Technical Specifications

---

## Environmental Specifications

- **Temperature**
  - Operating: 50 to 95 ºF (10 to 35 ºC)
  - Storage: –4 to 104 ºF (~20 to 40 ºC)
  - 1 month at 104 ºF (40 ºC)
- **Humidity**
  - Operating: 20 to 80% RH (non-condensing)
  - Storage: 5 to 85% RH

Parent topic: Technical Specifications
Interface Specifications

Interface type
- Hi-Speed USB (Device Class for computers)
- Hi-Speed USB (for PictBridge compliant device/Mass storage class for external storage)

Note: Epson cannot guarantee the operation of externally connected devices.

External USB Device Specifications

Note: Use only external storage devices with independent AC power sources. External storage devices that are powered via USB are not recommended. Epson cannot guarantee the operation of externally connected devices.

- CD-ROM/CD-R drive: 700MB maximum capacity, CD-RW is not supported
- DVD-ROM/DVD-R drive: 4.7GB maximum capacity, DVD-RW, DVD+R, DVD+RW, and Blu-ray Disc are not supported
- Magneto-optical drive: 1.3GB
- Hard disk and USB flash drives: 2TB, Formatted in FAT, FAT32, or exFAT.

Network Interface Specifications

Wi-Fi
- Standard: IEEE 802.11 b/g/n; complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on purchase location
Security
- WPA-PSK (TKIP/AES); complies with WPA2 with support for WPA/WPA2 Personal
- WEP (64/128 bit)

Frequency band
- 2.4 GHz

Communication mode
- Infrastructure mode
- Ad hoc mode
- Wi-Fi Direct

Note: Wi-Fi Direct Simple AP mode available even if you connect the product to an Ethernet network.

Ethernet
- Standard: IEEE802.3i/u, IEEE802.3az*
- Communication mode: Ethernet 100BASE-TX/10BASE-T

* The connected device should be IEEE802.3az compliant.

Safety and Approvals Specifications

United States
- Safety: UL60950-1
- EMC: FCC part 15 Subpart B class B

Canada
- Safety: CAN/CSA C22.2 No. 60950-1
- EMC: CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module:
- Manufacturer: Askey Computer Corporation.
- Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for any failure to satisfy the protection requirements resulting from a non-recommended modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to licensing.

**Parent topic:** Technical Specifications
Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to epson.com/recycle for information on how to return your products for proper disposal.

Important Safety Instructions

FCC Compliance Statement
Software Notice
Trademarks
Copyright Notice

Important Safety Instructions

Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions
Ink Cartridge Safety Instructions
LCD Screen Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Product Safety Instructions

• Be sure to follow all warnings and instructions marked on the product.
• Use only the type of power source indicated on the product's label.
• Use only the power cord that comes with the product. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
• Place the product near a wall outlet where the plug can be easily unplugged.
• Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
• Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over. Be careful to keep the cord straight at each end.
• If you use an extension cord with the product, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

• Always turn off the product using the power button, and wait until the power light stops flashing before unplugging the product or cutting off power to the electrical outlet.

• If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

• Place the product on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.

• Make sure the back of the product is at least 4 inches (10 cm) away from the wall.

• Allow space behind the product for the cables, and space above the product so that you can fully raise the document cover.

• Leave enough space in front of the product for the paper to be fully ejected.

• Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.

• Do not place or store the product outdoors.

• Do not place the product near excessive heat sources or in direct sunlight.

• Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the case or insert objects through the slots.

• Keep the product away from potential sources of electromagnetic interference, such as loudspeakers or the base units of cordless telephones.

• When connecting the product to a computer or other device with a cable, ensure the correct orientation of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may damage both devices connected by the cable.

• Do not touch the flat white cable inside the product.

• Do not move the print head by hand; this may damage the product.

• Do not spill liquid on the product or use the product with wet hands.

• Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause fire.

• Do not press too hard on the document table when placing originals.

• Do not open the scanner section while the product is copying, printing, scanning, or performing any other functions.

• Be careful not to trap your fingers when closing the document cover or scanner.
• Except as specifically explained in your documentation, do not attempt to service the product yourself.
• Unplug the product and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
• Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may prevent the product from printing.
• Before transporting the product, make sure that the print head is in the home (far right) position and the ink cartridges are in place.
• When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

• Keep ink cartridges out of the reach of children and do not drink the ink.
• Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
• Do not put your hand inside the product or touch any cartridges during printing.
• Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the product from printing.
• Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
• Do not shake cartridges after opening their packages; this can cause them to leak.
• If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
• Use an ink cartridge before the date printed on its package.
• Do not dismantle an ink cartridge. This could damage the print head.
• Store ink cartridges in a cool, dark place.
• After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.

Parent topic: Important Safety Instructions
LCD Screen Safety Instructions
• Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
• If the LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.
• Do not press too hard on the LCD screen.
• Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.

Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions
To avoid adversely affecting the operation of the following equipment and causing an accident, do not use the product:
• Near medical equipment in a medical facility.
• Within 8.7 inches (22 cm) of a cardiac pacemaker.
• Near automatically controlled devices, such as automatic doors or fire alarms.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
WARNING
The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification or Declaration of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Software Notice

1. This printer product includes open source software programs listed in Section 6) according to the license terms of each open source software program.

2. We provide the source code of the GPL Programs, LGPL Programs, Apache License Program and ncfp license Program (each is defined in Section 6) until five (5) years after the discontinuation of same model of this printer product. If you desire to receive the source code above, please contact the customer support of your region. You shall comply with the license terms of each open source software program.

3. The open source software programs are WITHOUT ANY WARRANTY; without even the implied warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. See the license agreements of each open source software program for more details, which are described in OSS.pdf on your Printer Software CD.

4. OpenSSL toolkit
   This printer product includes software developed by the OpenSSL project for use in the OpenSSL Toolkit (http://www.openssl.org/).
   This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).

5. The license terms of each open source software program are described in OSS.pdf on your Printer Software CD.

6. The list of open source software programs which this printer product includes are as follows.

   GNU GPL
   This printer product includes the open source software programs which apply the GNU General Public License Version 2 or later version ("GPL Programs").
The list of GPL Programs:
linux-2.6.35-arm1-epson12
busybox-1.17.4
udhcp 0.9.8cvs20050124-5
ethtool-2.6.35
GNU LGPL
This printer product includes the open source software programs which apply the GNU Lesser General Public License Version 2 or later version ("LGPL Programs").
The list of LGPL Programs:
uclibc-0.9.32
libusb-1.0.8
zeroconf 0.6.1-1
iksemel-rev25
Apache License
This printer product includes the open source software program "Bonjour" which apply the Apache License Version2.0 ("Apache License Program").
Bonjour License
This printer product includes the open source software program "Bonjour " which applies the terms and conditions provided by owner of the copyright to the "Bonjour ".
Net-SNMP license
This printer product includes the open source software program "Net-SNMP" which applies the terms and conditions provided by owner of the copyright to the "Net-SNMP":
OpenSSL License/Original SSLeay License
This printer product includes the open source software program "OpenSSL toolkit" which applies the license terms of OpenSSL License and Original SSLeay License.
BSD License (Berkeley Software Distribution License)
This printer product includes the open source software program "busybox-1.17.4 " which apply the Berkeley Software Distribution License ("BSD Program").
Sun RPC License
This printer product includes the open source software program "busybox-1.17.4 " which apply the Sun RPC License ("Sun RPC Program").

ncftp license
This printer product includes the open source software program "ncftp-3.2.4 " which applies the terms and conditions provided by owner of the copyright to the "ncftp ".

ARC4 license
This printer product includes the open source software program "ARC4" which applies the terms and conditions provided by owner of the copyright to the "ARC4".

json_parserlicense
This printer product includes the open source software program "json_parser" which applies the terms and conditions provided by owner of the copyright to the "json_parser ".

MD5 license
This printer product includes the open source software program "MD5" which applies the terms and conditions provided by owner of the copyright to the " MD5 ".

AES license
This printer product includes the open source software program "AES" which applies the terms and conditions provided by owner of the copyright to the "AES".

SHA1 license
This printer product includes the open source software program "SHA1" which applies the terms and conditions provided by owner of the copyright to the "SHA1".

Parent topic: Notices

Trademarks
EPSON®, Supplies Central®, and Supplies Central® are registered trademarks; EPSON Exceed Your Vision is a registered logomark; and Epson Connect™, Epson iPrint™, and Remote Print™ are trademarks of Seiko Epson Corporation.

Epson Store℠ is a service mark of Epson America, Inc.

Apple, iPad, iPhone, iPod touch, Mac, and Mac OS are trademarks of Apple Inc., registered in the U.S. and other countries. AirPrint is a trademark of Apple Inc.
General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that occurs from the use of any interface cables other than those designated as Epson approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

libTIFF Software Acknowledgment

Copyright © 1988-1997 Sam Leffler

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (I) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution

© 2014 Epson America, Inc.
2/14
CPD-39353R1

Parent topic: Copyright Notice